Apex User Guide
Table of Contents

How to use Apex Online Help ................................................................................................................................. 1
Navigate the Table of Contents ................................................................................................................................. 1
Finding a Topic in Help ............................................................................................................................................... 1
Help Toolbar Buttons ................................................................................................................................................. 1
Find Topics Using the Browse Sequences ................................................................................................................. 2
Highlight Words in Searched Topics ......................................................................................................................... 2
Printing a Help Topic .................................................................................................................................................. 2
Resize the Help Viewer ................................................................................................................................................ 2
  Using Full-Text Search ............................................................................................................................................ 3
Use Full-Text Search .................................................................................................................................................. 3
Searching for Help Topics ......................................................................................................................................... 3
Find Words Similar to Your Search Term .................................................................................................................... 3
Search for Words in the Titles of HTML Files ........................................................................................................... 3
Search Only the Last Group of Topics you Searched ................................................................................................. 4
Help Videos ............................................................................................................................................................... 4
General Information .................................................................................................................................................... 5
Activating Apex .......................................................................................................................................................... 5
Navigating the Startup Screen .................................................................................................................................. 5
Customer Contact Center (CCC) ............................................................................................................................... 5
  Learning the Basics of Windows .............................................................................................................................. 6
Menu Bar .................................................................................................................................................................... 6
Minimize, Maximize, Restore, and Close .................................................................................................................. 6
Resize Screens and Windows ..................................................................................................................................... 6
Backup and Restore Data .......................................................................................................................................... 9
Backup and Restore Apex Data ................................................................................................................................ 9
Setup ........................................................................................................................................................................ 11
  Enterprise .............................................................................................................................................................. 12
Client Setup .............................................................................................................................................................. 12
Farm Setup ............................................................................................................................................................... 12
Field Setup ............................................................................................................................................................... 12
  Guidance Setup .................................................................................................................................................. 13
Task Setup ............................................................................................................................................................... 13
  Products ............................................................................................................................................................... 13
Crop Setup ................................................................................................................................................................. 13
  Variety/Hybrid .................................................................................................................................................... 14
Fertilizer Setup ......................................................................................................................................................... 14
Chemical Setup ......................................................................................................................................................... 15
Carrier Setup ............................................................................................................................................................ 15
  Tank Mix Setup ................................................................................................................................................ 15
  Resources .......................................................................................................................................................... 16
Machine Setup ........................................................................................................................................................ 16
  Implement Setup ................................................................................................................................................ 16
Operator Setup ......................................................................................................................................................... 16
  Miscellaneous .................................................................................................................................................. 17
Legend ..................................................................................................................................................................... 17
Flag Names Setup ...................................................................................................................................................... 17
Load Name Setup ...................................................................................................................................................... 18
Load Destination Setup ............................................................................................................................................ 18
Multi-Client System ................................................................................................................................................ 18
Menu Commands ..................................................................................................................................................... 19
View Menu Commands .......................................................................................................................................... 19
File Menu Commands ............................................................................................................................................. 19
Setup Menu Commands ......................................................................................................................................... 19
Reports Menu Commands ..................................................................................................................................... 20
GSDNet Menu Commands ..................................................................................................................................... 21
Help Menu Commands .......................................................................................................................................... 21
Preferences .............................................................................................................................................................. 23
# Table of Contents

Functional Area in Field Map .......................................................... 59  
Map Layers ....................................................................................... 59  
Summary Map Layers ....................................................................... 59  
Background Maps ........................................................................... 59  
Application Maps ........................................................................... 60  
Boundaries ....................................................................................... 60  
Composite Maps ............................................................................. 61  
Delta T Maps .................................................................................. 62  
Flag Maps ........................................................................................ 62  
Guidance Maps ............................................................................... 62  
Harvest Maps .................................................................................. 63  
Management Zone Maps .................................................................. 63  
Prescription Maps ........................................................................... 64  
Seeding Maps .................................................................................. 64  
Tillage Maps .................................................................................... 64  
Temperature Maps .......................................................................... 64  
Wind Speed Maps ........................................................................... 64  
Map Tree and Right Click Options .................................................... 65  
Edit Options .................................................................................... 65  
Profit ............................................................................................... 67  
Profit ............................................................................................... 67  
Create Price Template ..................................................................... 68  
Edit Price Template ......................................................................... 71  
Import Price Template ...................................................................... 72  
Export Price Template ..................................................................... 72  
Apply Price Template ....................................................................... 73  
Enterprise Summary ......................................................................... 74  
Field Summary ................................................................................ 75  
Operation Summary ......................................................................... 75  
Operator Summary .......................................................................... 76  
Product Summary ........................................................................... 77  
Reports Tool Bar .............................................................................. 78  
Legends ............................................................................................ 81  
Legend .............................................................................................. 81  
Legend Templates ............................................................................ 81  
Creating a Legend Template .............................................................. 81  
Generate a New Legend Template ...................................................... 82  
Modify an Existing Template ........................................................... 83  
Use as Default ................................................................................ 83  
Create a Legend by a Map ............................................................... 83  
Edit a Legend Template ................................................................. 83  
Edit a Map Legend ......................................................................... 84  
Saving a Map Legend as a Template ................................................ 84  
Apply a Map Legend to Another Map .............................................. 84  
Normalize Maps ............................................................................ 85  
Boundaries ....................................................................................... 87  
Boundaries ....................................................................................... 87  
Create A New Boundary .................................................................. 88  
View Boundary ............................................................................... 88  
Create A New Boundary .................................................................. 88  
Create Exterior Boundaries Manually .............................................. 89  
Create Interior Boundaries Manually .............................................. 89  
Edit Existing Boundaries ................................................................. 89  
Boundary Summary ......................................................................... 90  
Boundary Create Functional Area .................................................... 90  
Print Boundary .............................................................................. 91  
Save Boundary to Data Card ........................................................... 91  
Guidance ......................................................................................... 93  
A/B Guidance Tracks ...................................................................... 93  
A/B Curves ..................................................................................... 93  
Curved Tracks ................................................................................ 93  
Circle Track Lines .......................................................................... 94
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Data</td>
<td>125</td>
</tr>
<tr>
<td>Edit Season</td>
<td>126</td>
</tr>
<tr>
<td>Edit Task</td>
<td>126</td>
</tr>
<tr>
<td>Edit Variety</td>
<td>126</td>
</tr>
<tr>
<td>Edit Width</td>
<td>127</td>
</tr>
<tr>
<td>Edit Machine</td>
<td>127</td>
</tr>
<tr>
<td>Edit Implement</td>
<td>127</td>
</tr>
<tr>
<td>Edit Operator</td>
<td>128</td>
</tr>
<tr>
<td>Edit Chemical</td>
<td>128</td>
</tr>
<tr>
<td>Edit Fertilizer</td>
<td>128</td>
</tr>
<tr>
<td>Edit Field Notes</td>
<td>129</td>
</tr>
<tr>
<td>Edit Notes</td>
<td>129</td>
</tr>
<tr>
<td>Uninstall Apex</td>
<td>131</td>
</tr>
<tr>
<td>Apex 3.1 Uninstall</td>
<td>131</td>
</tr>
<tr>
<td>Surface Water Management</td>
<td>133</td>
</tr>
<tr>
<td>Drain Design</td>
<td>133</td>
</tr>
<tr>
<td>Ditch Track</td>
<td>133</td>
</tr>
<tr>
<td>Elevation Data Map</td>
<td>135</td>
</tr>
<tr>
<td>Digital Elevation Map</td>
<td>135</td>
</tr>
<tr>
<td>Drainage Map</td>
<td>136</td>
</tr>
<tr>
<td>Depression Map</td>
<td>136</td>
</tr>
<tr>
<td>Mobile Farm Manager</td>
<td>139</td>
</tr>
<tr>
<td>John Deere Mobile Farm Manager</td>
<td>139</td>
</tr>
<tr>
<td>Export Data from Apex to Mobile Farm Manager</td>
<td>139</td>
</tr>
<tr>
<td>Import Data to Apex From Mobile Farm Manager</td>
<td>139</td>
</tr>
</tbody>
</table>
How to use Apex Online Help

Navigate the Table of Contents

There are three types of icons within the online Help system. Picture the Help System as an outline.

- Closed books
- Open books
- Sheets of paper

Closed books are topics that contain several other topics. Sheets of paper are the actual topics that contain the help information. To open a closed book, double click on “Closed Book” icon and the book will open displaying the “Open Book” icon and the topics in the book. Click once on the sheets of paper to view the topic and the topic information will appear on the right. To close the book, double click on the “Open Book” icon.

The Help Guide contains an index if you prefer to look for information on a specific topic. Type in the key words at the top and the topics will be highlighted in the index. Click on the highlighted topics to see the information.

If at any time, while in Apex, you would like to open Help, press the F1 key on your keyboard and it will bring up the help documents pertaining to the area you are in.


1. Select “Support & Downloads” from the menu on the left side.
2. Refer to the “Manuals & Instructions” tab in the center of the page and select “OMs and User Guides.”
3. In the Desktop software section select “Apex Users Guide.”

Finding a Topic in Help

In the Navigation pane, click one of the following tabs: Contents, Index, or Search.

To browse through a table of contents, select the “Contents” tab. The table of contents is an expandable list of important topics.

To see a list of index entries, select the “Index” tab, and then type a word or scroll through the list. Topics are often indexed under more than one entry.

To locate every occurrence of a word or phrase that may be contained in a help file, select the “Search” tab, and then type the word you want to search.

Help Toolbar Buttons

There are several navigational buttons that can be located on the toolbar in the Help Viewer. You can click these buttons below to do the following::
Apex User Guide

- **Hide** - hides the left viewing pane that displays the table of contents.
- **Show** - if the left view pane is currently hidden this brings the table of contents back.
- **Back** - displays the last topic you viewed.
- **Forward** - displays the next topic in a previously displayed sequence of topics.
- **Stop** - stops downloading file information. Click this button to stop a Web page from downloading.
- **Refresh** - updates Web content that is currently displayed in the topic pane.
- **Home** - displays the Home page topic for the help file you are viewing.
- **Print** - allows you to print the selected topic or print the selected heading and all subtopics.
- **StellarSupport** - Navigates user to the StellarSupport home page.

**NOTE:** The toolbar in your Help Viewer may not contain all of these navigational buttons.

---

**Find Topics Using the Browse Sequences**

In addition to using the table of contents to browse Help topics, Apex Help also provides a browse sequence to view and find information. These topics, unlike the table of contents, are arranged in alphabetical order.

---

**Highlight Words in Searched Topics**

When searching for words in help topics, each occurrence of the word or phrase will be highlighted in the topics that are found. If you are viewing a long topic, only the first 500 instances of a search word or phrase will be highlighted.

---

**Printing a Help Topic**

In the Help topic you want to print, select the "Print" icon on the Help Menu Bar.

You can also use the right click options on your mouse to click "Print."

You can print the selected topic or print the selected heading and all subtopics by clicking on the book.

---

**Resize the Help Viewer**
There are a few ways to easily change the size and position of the Help Viewer and the panes in the viewer:

1. To resize the Navigation or Topic pane, point to the divider between the two panes. When the pointer changes to a double-headed arrow, drag the divider right or left.

2. To proportionately shrink or enlarge the whole Help Viewer, point to any corner of the Help Viewer. When the pointer changes to a double-headed arrow, drag the corner.

3. To change the height or width of the Help Viewer, point to the top, bottom, left, or right edge of the Help Viewer. When the pointer changes to a double-headed arrow, drag the edge.

4. To reposition the help viewer on your screen, click and drag the viewer to a new position.

5. The Help Viewer will appear with the last size and position settings you specified when it is opened again.

**Using Full-Text Search**

**Use Full-Text Search**

1. Select the "Search" tab, and then type the word or phrase you want to find.
2. Click "List Topics," select the topic you want, and then click "Display."

**Note:** The toolbar in your Help Viewer may not contain all of these navigational buttons.

**Searching for Help Topics**

A basic search consists of the word or phrase you want to find. The rules for formulating queries are as follows:

- Searches are not case-sensitive, so you can type your search in uppercase or lowercase characters.
- You may search for any combination of letters (a-z) and numbers (0-9).
- Punctuation marks such as the period, colon, semicolon, comma, and hyphen are ignored during a search.
- Group the elements of your search using double quotes or parentheses to set apart each element. You cannot search for quotation marks.

**Find Words Similar to Your Search Term**

This feature enables you to include minor grammatical variations for the phrase you search. For example, a search on the word "add" will find "add," "adds," and "added."

1. Select the "Search" tab, type the word or phrase you want to find, and then select the "Match similar words" check box.
2. Click "List Topics," select the topic you want, and then click "Display."

**Note:** This feature only locates variations of the word with common suffixes. For example, a search on the word "add" will find "added," but it will not find "additive."

**Search for Words in the Titles of HTML Files**
1. Select the "Search" tab, type the word or phrase you want to find, and then select the "Search titles only" check box.

2. Click "List Topics," select the topic you want, and then click "Display."

Note: If you use this option, all HTML topic files will be searched, including any that are not listed in the table of contents.

Search Only the Last Group of Topics you Searched

This feature enables you to narrow a search that resulted in too many topics found. You can search through your results list from a previous search by using this option.

1. On the "Search" tab, select the "Search previous results" check box.

2. Click "List Topics," select the topic you want, and then click "Display."

Note: If you want to search through all of the files in a help system, this check box must be cleared. The search tab will open with this check box selected if you previously used this feature.

Help Videos

There are tutorial videos available in the help drop down menu to assist with specific tasks.

NOTE: Must have internet access to view videos.
General Information

Activating Apex

Every installation of Apex will work as an evaluation copy for 30 days. Every install will produce a unique site code that will be used to activate the program. For easy activation log onto www.StellarSupport.com, select your country, then select "Activations and Subscriptions" on the left hand menu.

A GreenStar Apex Trial will work for a 30-day evaluation period. The trial can be activated by going to the Help > License Manager. Select GreenStar Apex and click Activate. If the evaluation trial period has expired, you must activate Apex to open the program.

Apex is limited to two activations per copy of Apex.

If you have activated Apex and need to reactivate the same copy for any reason, you will need to contact the Customer Contact Center (CCC).

Further information on the items below can be found in the User Guide under Preface.

• Instructions to Activate Apex
• Instructions to Transfer Apex Activation
• Apex Installation Instructions
• Apex Uninstall Instructions
• Apex Automatic Backup

Navigating the Startup Screen

When Apex opens, you will be viewing the Home Page, which will provide you with two methods of navigation.

The first method of navigation is the top navigation bar available on every section of Apex. The top navigation bar provides you with shortcut icons that open different areas of Apex.

The second method of navigating Apex is the globe image in the center of the Home Page. This provides you with the ability to navigate Apex according to the field operation you have completed or planning to complete.

Customer Contact Center (CCC)

www.stellarsupport.com
E-mail: GreenStar@JohnDeere.com
North America Activations only: 1-888-953-3373
North America Support: 1-888-GRN-STAR (1-888-476-7827)
Australia: 0011-800-833-3373
New Zealand: *(000911) 877-712-6449
Brazil: 0-800-891-4031
Mexico: 866-582-4068
Argentina: 0800-444-9126
South Africa: 0800-983-821
Zimbabwe: *(110-98990) 888-983-3373
Zambia: *(00-899) 888-923-3373

*Countries w/ Access codes – Dial access code first and once prompted, enter the toll free number.
Technology is changing fast, and in order to support our customers to the best of our abilities, John Deere Ag Management Solutions provides an internet support site, www.stellarsupport.com, to complement your local John Deere dealer and the CCC. Also on the Stellar Support website, the following help and training documents can be found:

• Apex Tutorials
  Tutorials can be viewed by going to www.StellarSupport.com. Select the “Training” tab on the left side of the screen and under the tutorials section select the Apex Tutorials link.

• Apex User Guide
  The Apex help guide can be viewed when working in the Apex program. Open the help guide by selecting the “F1” key on your computer keyboard. You can also access the Help Guide by selecting “Help > Help Topics” located on the menu bar.

Learning the Basics of Windows

Menu Bar

Windows-based programs use pull-down menus to organize and provide easy access to commands. Each menu category is listed below the title of the application in the menu bar. There are also sub-menus within some menus; these are indicated by a right-pointing arrow.

Select “Setup > Enterprise > Client” to allow you to access the client sub-menu in the setup menu. Any commands that cannot be executed at that point in the program will be shown on the menu in gray (this is referred to as “grayed-out”).

Minimize, Maximize, Restore, and Close

All applications (and most windows) have three buttons at the top right corner of the screen.

To minimize a window or application (collapses your screen to the task bar), click ☐.

To maximize a window or application (fill your entire screen), click ☐.

To restore a window or application (to regular size), click ☐.

To close a window or application, click ☐.

Resize Screens and Windows

You may find that some windows within Apex are not large enough to support all of the data that may be found there. This is most common when viewing map layers. To expand the size of a window, place the mouse pointer on a
border; the cursor will convert to a two-headed arrow if it is expandable. Click and drag the border inward or outward to change the size.
Backup and Restore Data

Backup and Restore Apex Data

Reference Apex to MyJohnDeere User Guide at the end of this user manual.
Setup

Setup Icon

Setup contains all of the information that pertains to your farming operation. Data contained on these tabs will be transferred to the display to populate the pick lists. This section controls what you see, and do not see, on the pick lists. In addition, it is used as the building blocks for all other commands you want to do in Apex.

After saving your Setup data to the Card, insert the card into the Mobile Processor or GreenStar 2 Display. When the machine is started, the Setup information will be available on the display.

To Open Setup:

1. From the Startup screen, click on the "Setup" icon or select the "Setup" tab in the top right corner.
2. Select one of the setup items in the left hand side bar.

Enterprise:

CLIENT - This is the name of the farmer or farm owner.

FARM - A group of fields that are located close to each other.

FIELD - This is a field that is associated with a specific farm (i.e. Jones farm contains 3 fields).

GUIDANCE - Assign global straight tracks, curved tracks, and circle tracks to specific client, farm, and field for use in GS2.

TASK - This is an operation, or operations, that may occur in a field (i.e.: If you are planting you may be running multiple operations: tillage, planting, and fertilizer).

Products:

CROP - Apex has an extensive list of crops available (i.e. Corn, Soybeans, and Wheat).

VARIETY - Each crop has its own variety list (i.e. 35Y65, AG2705).

FERTILIZER - This section lists all fertilizers in Apex (i.e. Lime, NPK).

CHEMICAL - This section lists all chemicals in Apex (i.e. Herbicide, Insecticide).

CARRIER - This section lists all carriers in Apex (i.e. Water).

TANK MIX - When two or more chemicals or fertilizers are combined, a tank mix can be created and entered in this section.

Resources:

MACHINE - User enters machines that will record information (i.e. Tractors, Combines, Sprayers, etc).

IMPLEMENT - User enters equipment used to perform field operations recorded with the GreenStar system needs to be entered in this section (i.e. Planter, Field Cultivator, or Corn Head, etc).

OPERATOR - User enters operators of equipment used in the field during the operation can be entered in this section.

Miscellaneous:
LEGEND - Legends are used to explain the characteristics of each map. This option allows you to add new, modify, delete, and apply specific legend templates.

FLAG - User enters flags that are used to track field conditions. This option allows you to define a flag name which can be used to create flags.

LOAD NAME - Users can enter load names for different loads logged in fields.

LOAD DESTINATION - Users can specify where a load is taken using the load destination feature.

Enterprise

Client Setup

A client is the highest level of an organizational structure used in Apex. A client can be a name of an incorporated farming operation, an individual, or a customer of a farm manager whose data will be stored in Apex. The “Client Maintenance” page is where clients can be added, modified, retired, or deleted.

NEW
MODIFY
RETIRE
DELETE

Multi-Client System

Farm Setup

A farm is a group of fields that provides an organizational structure for each client. Fields are organized into farms based on meaningful relationships between a set of fields (fields may have the same owner or be geographically located near each other). Grouping fields into farms also helps reduce the length of the pick lists on the GreenStar displays. The “Farm Maintenance” page is where farms can be added, modified, retired, or deleted.

NOTE: Avoid using years and crops in farm and field names. Farm and field names without reference to years and crops ensure names will span across years and crops.

NEW
MODIFY
RETIRE
DELETE

Field Setup
Growers may define fields based on property boundaries, cropping systems, management units, or ownership of land. Because of these perspectives, Apex identifies fields as geographic areas defined by growers that usually represent a cropping system each year. Fields are the smallest unit in the Apex organizational structure and therefore are always associated with a Farm and a Client. The “Field Maintenance” page is where fields can be added, modified, retired, or deleted.

**Guidance Setup**

1. Go to Setup > and under Enterprise > select Guidance.
2. Select the Tracking Mode to view the correct lines.
3. Place checks next to the Field Numbers for lines that are being assigned.
4. Next, use the drop downs to select the correct Client, Farm and Field for each line.
5. Once the lines have been assigned, press the Done button in the lower right. If you do not like the changes that have been made, press the Reset button to undo the changes.

**Note:** These newly assigned lines will now be available once they are saved to the card for the GreenStar 2 System. Lines 6 through 250 will still be assigned as numbers in the Original GreenStar System.

**Task Setup**

A task is one or more operations performed within a field and may include detailed information specific to each operation. For example, a task could be Planting, Harvesting, or Tillage.

**Products**

**Crop Setup**
All of the crops that Apex supports are listed alphabetically on this tab - crops cannot be added or deleted but they can be retired. The Crop tab is independent of the year, farm, or field.

The standard payable moisture and crop weight are used to calculate the average dry yields and total dry yields. These calculations adjust the measured wet yield to a dry yield by reducing the moisture from the actual level recorded by the sensors in the combine to the standard payable moisture at the grain elevator.

Yield is calculated by the GreenStar Display; therefore any changes to these values need to be saved to the Card prior to going to the field. If your local elevator uses different values, update these numbers prior to unloading your data.

1. Payable crops in the crop maintenance page cannot be added or deleted, only modified or retired
2. Payable weight is not test weight
3.

**MODIFY**

**RETIRE**

**Variety/Hybrid**

Apex organizes varieties/hybrids to document seed brand by crop. Each crop has its own variety list; this results in multiple, short pick lists instead of one long list in the GreenStar Display.

The same variety/hybrid can be used in multiple fields and across all years. Apex provides a few sample varieties/hybrids for specific crops. You will need to add any specific varieties/hybrids used in your farming operation. If you change a variety/hybrid name, then all instances where it is referenced will change.

You can also add Seeding Information to a specific variety/hybrid.

- Seed count
- Seed Weight

The previous information will be used when creating a prescription in Apex to calculate: total seeds needed, seed amount, and total packages needed. This will give you a seed count needed based on planting population and acres planted. This information will be displayed in the summary panel after the prescription is created.

**NEW**

**MODIFY**

**RETIRE**

**DELETE**

**Fertilizer Setup**

Apex organizes fertilizers by type (Fertilizer, Manure, or Nitrogen Stabilizer). You may need to add fertilizers used in your farming operation. If you edit a fertilizer, all instances where it is referenced will be changed.

**NEW**

**MODIFY**
Chemical Setup

A pesticide is any chemical that is used to control pests. Pests include: insects, plant diseases, fungi, weeds, etc. Therefore, insecticides, fungicides, herbicides, and additives are all types of pesticides. Apex organizes pesticides by type; you will need to add any specific pesticides you want to track. If you edit a listed pesticide, all instances where it is used will be impacted.

Apex includes a Setup to define tank mixes; you are free to mix pesticides of any type together as label restrictions will apply. Refer to the tank mix section for more information.

Carrier Setup

Most pesticides need to be diluted with other liquids before use; water is the most common liquid used. If you are using tank mixes, you will need to define the carriers in this section prior to entering the data in the Tank Mix section (carriers defined here automatically populate the Carrier drop-down list on the Tank Mix tab).

Tank Mix Setup

Often two or more chemicals or fertilizers are mixed together during the same spraying application (follow product label instructions to provide guidance concerning compatibility).

The Tank Mix section allows you to define all the mixes you will use during the year. There is a limit of six (6) products within one tank mix.
Resources

**Machine Setup**

One entry will be made for each piece of equipment that has recorded data with a GreenStar system. Apex organizes machines by type, and the most common models are listed for each. If you use a model that is not listed, you need to create a new entry for it and add it to the appropriate type list.

**NEW**
**MODIFY**
**RETIRE**
**DELETE**

**Implement Setup**

You have the option to enter each implement that has recorded data with a GreenStar system. Apex organizes implements by type, and the most common models are listed for each type. If you use a model that is not listed, you need to create a new entry for it and add it to the appropriate list. The reason for entering the implement is to record the accurate information for each piece of equipment.

**NEW**
**MODIFY**
**RETIRE**
**DELETE**

**Operator Setup**

An operator is anyone who drives or operates equipment in the field. By entering operators names in this list and saving to the data card, the actual in-field operator can select the applicable name to record their operation. The operator's specific data can be used to produce reports that will show you who performed what operations, with what equipment, along with how many acres were covered.

**NEW**
Legend

To ensure that a person can correctly read a map, a Map Legend gives you explanation of colors or symbols used on a map. Similar to a dictionary, the legend provides you the meaning of what colors or symbols on the map represent. For example, you may use the color green to illustrate high yielding corn on your map, so this color is set to display all yield values from 190-350 bu/ac. Matching a range of values to a color will help you make comparisons of multiple field maps.

Legend Templates

Normalize Maps

Flag Names Setup

Flags are markers that are used to track field conditions on maps. There are three types of flags: area flags, point flags, and line flags.

Area flags represent multiple data points that were covered by the vehicle. Point flags are simply one data point, and a line flag is multiple points following the line to the object or path.

Flags can be unloaded and edited in Apex. You can also create new flags in Apex. These flags can be saved to card for use in GS2.

VIEW FLAG
CREATE
NEW
MODIFY
RETIRE
DELETE
RIGHT CLICK OPTIONS
EDIT FLAGS
FLAG LEGEND
FLAG SUMMARY
SAVE FLAG TO CARD
PRINT A FLAG

Load Name Setup

Load name shows all of the Loads created.

ADD
MODIFY
RETIRE
DELETE

Load Destination Setup

Load Destination shows where the load is located.

ADD
MODIFY
RETIRE
DELETE

Multi-Client System

Every installation of Apex has multi-client functionality, providing you with the ability to organize your farms and fields under different clients.

Example: Separating your custom farming operation from your individual operation.

Maps and reports will utilize these clients to organize your data and also provide you with the ability to display/report on one, or multiple clients’ information.

Apex does not separate products (i.e. varieties) or resources (i.e. machines) by client. These items can be used for any and all clients.

NOTE: The Multi-client functionality will work on Original GreenStar, or GreenStar2 systems with Harvest Doc, but will not work with Yield Mapping on Original GreenStar systems. The Original GreenStar Yield Mapping system is a single client program.

Setup a Client
Menu Commands

View Menu Commands

Go To >

To go Home (Startup Screen) you can go File > Go To > Home or click on the icon on the toolbar.

To go Back to a previous page you can go File > Go To > Back or click on the icon on the toolbar.

To go Forward to a page you can go File > Go To > Forward or click on the icon on the toolbar.

File Menu Commands

Save to Card
Unload
Transfer
Preferences
Import
Export Map
Clean Card
Backup/Restore
Exit

Setup Menu Commands

Enterprise >
    Client
    Farm
    Field
    Guidance

Products >
After selecting the “Reports” tab or “Reports” icon you will see the following categories and their respective subcategories in the menu:

**User Preference >**
- Preferences

**Seeding >**
- Seeding Summary
- Field Summary

**Application >**
- Application Summary
- Field Summary

**Harvest >**
- Harvest Summary
- Field Summary
GSDNet Menu Commands

GSDNet utilizes a web based application which provides a simple and efficient solution to import free map layers such as aerial images and soil data.

To import map layers from GSDNet, you must first create a free user account at www.gsdnet.com. After you have created an account, select the GSDNet icon and log in with your username and password.

GSDNet works hand-in-hand with a Geographic Information system (GIS) which is a collection of computer hardware, software and geographic data for capturing, managing, analyzing and displaying all forms of geographically referenced information. GSDNet provides information to help you make smart agronomic decisions in your farming operation.

To access GSDNet simply click on the GSDNet connection located on the left side of the screen.

Help Menu Commands

After selecting the “Help” tab you will see the following categories and their respective subcategories in the menu:

Help Topics: Opens the Help Contents tab.

License Manager: Opens an information screen for activation or deactivation.

About GreenStar Apex: Opens an informational GreenStar Apex splash screen. This screen will show you which version of Apex you are using.

Live Update: Opens up Apex Live Update and checks for updates to ensure you have the most current version installed.

NOTE: For a step by step guide to open up Apex Live Update click here otherwise you can select "Automatically Check Apex Update" under "File > Preferences." The Automatically Check option will trigger the Live Update based on Preference i.e. Daily or Weekly (default) or Monthly.
Before data is unloaded from the Card, Apex preferences need to be selected. These settings affect the general behavior of the program, and are separated into four categories.

To access preferences go to “File > Preferences.”

1. GENERAL
2. MAPS
3. FILE PROCESSING
4. REPORTS

To access preferences go to “File > Preferences.” The following screen will appear:
Data Management

Import Files

Apex has three types of imports:

Management Zone: A management zone classifies an area of ground. All other areas of and with the same classification will receive the same management. Management zone maps provide a color description of the management zone within a field. Apex offers the ability to import shapefiles from external sources and view reports about information provided. It is recommended to import shapefiles in the WGS84 format.

Field Boundary: Apex offers the ability to convert field boundaries in the shapefiles format to Apex field boundaries. To convert the shapefile to a field boundary the shapefile can not contain multiple zones.

Image Layer: Apex can import a variety type of aerial images. These images must be geo-referenced in order to be imported into Apex.

Import Management Zones

A management zone classifies an area of ground to a field characteristic. For example, colors in a soil map identify changes in soil type across the field. Areas of land with the same classification will receive the same management zone and color to describe variation within a field. Apex offers the ability to import management zone shapefiles from external sources. It is recommended to import shapefiles in the WGS84 format.

To Import a Management Zone

1. Select “File > Import.” This will open the “Import Management Zone” window.

2. Next, select the file path for where the data is located on your computer. In the “Select Map file” box, select the “Ellipsis” button located on the right side of the “File Path” box.

3. Locate the file to be imported (hard drive, data card, etc.) and select the “Open” button.

4. Select the field information in the “Select Field” box. This box will allow you to select the Client, Farm and Field that you want the management zone to be associated with when you import the management zone into Apex.

NOTE: If the information is not populated in the drop down box, refer to the setup screens and enter the desired information.

5. In the “Layer Name” box, enter a unique name for the imported management.

Apex offers two options in the “Data Import Options” box allowing you to choose what information will be imported with the shapefile. “Import all Attributes” will import all attributes that are available to be imported with the shapefile. “Import Selected Attributes Only” will give you the option to place a check by the attributes you want to be imported with the imported shapefile.

6. Select the attributes that you want to be associated with the imported shape file in the “Data Import Options” box.

Apex offers three options to clip the shapefile to a boundary or import the shapefile without assigning a boundary. The options are as follows:

- Clip to field boundary - The shapefile will be clipped to the field boundary.
- Don’t Clip - No field boundary is needed to import the shapefile.
- Clip larger than field - If the shapefile covers more area than the border then the user has the option to clip the shapefile to the size of the border or larger by a specified number of feet or meters by choosing the “Width Offset” or
“Height Offset.” When this option is selected you can specify your offset units by clicking the dropdown arrow to the right of these options.

7. In the “Clipping Options” box select the clipping method of your choice.

8. Select the “Import” button to import the management zone.
   • Apex will display a message notifying you that the layer was imported successfully.

**SELECT FARM INFORMATION**

**LAYER NAME**

**VIEW MANAGEMENT ZONES**

**SHAPEFILES**

---

**Import Field Boundary**

Field Boundary – Apex offers the ability to import field boundaries in the shapefile format. When importing a shapefile to a field boundary in Apex, the shapefile can contain single or multiple polygons for the selected Client, Farm and Field.

To Import a Field boundary

1. Select “File > Import.” This will open the “Import Management Zone” window.

2. On the left side of the screen select the “Field Boundary” link and this will open the “Import Field Boundary” window.

3. Next, select the file path for where the data is located on your computer. Select the “Ellipsis” button located on the right side of the “File Path” box.

4. Locate the file(s) to be imported (hard drive, data card, etc.) and select the “Open” button.

5. Apex will auto-populate the Client, Farm, Field if that information is available in the shapefile.

6. The Client, Farm, Field can be changed by clicking on the Client, Farm, Field. Users can also change the headers of the Client, Farm, Field. This will change the Client, Farm, Field depending on what information is available in the headers.

NOTE: If the Client, Farm, Field does not exist in Apex, Apex will create that Client, Farm, Field in the Setup menu.

7. Select the “Import” button to import the boundary.

8. Apex will import the boundaries and automatically name the boundaries in the Map Tree.

Apex will display a message notifying you that the boundary was imported successfully.

NOTE: If projection information is provided with your shapefile (.prj file) Apex will project your data to match the coordinate system of your map layers. If no projection information is provided, Apex will assume a projection of WGS84.

---

**Import Image Layer**

Apex can import a variety of aerial images to display in the background of your map layers. These images must be geo-referenced in order to be imported into Apex. Apex can import aerial images that are in the following formats:

NOTE: Some of the files above may be accompanied with a geo-referenced text file (tif world file .tfw or JPEG world .jpw) for the file to be imported into Apex.

To Import an Image Layer

1. Select “File > Import.” This will open the “Import Management Zone” window.

2. On the left side of the screen select the “Image Layer” link and this will open the “Import Image Layer” window.

3. Next, select the file path for where the data is located on your computer. In the “Select Map file” box, select the “Ellipsis” button located on the right side of the “File Path” box.

4. Locate the file to be imported (hard drive, data card, etc.) and select the “Open” button.

Shapefiles

Shapefiles refer to the ESRI® open spatial data format. Apex allows for the export of all operational layers in shapefile format for easy and standardized data exchange. Shapefiles are not one single file, but rather a collection of files including a database file (.dbf), a spatial file (.shp), an indexing file (.shx) and a projection file (.prj). In order for a shapefile to be considered valid, the .dbf, .shp, and .shx files must be present.

Apex has the ability to import polygon and point shapefiles as management zones or a single polygon shape as a field boundary (See Section “Import Field Boundary”). Apex also supports shapefiles that are geo-referenced with a projection (.prj) file. If your shapefile does not contain a .prj file, Apex will assume your file is in the WGS84 projection.

Apex has the ability to export a single operation layer or batch export many layers at one time in .shp format (including all required files, .shp, .shx, .dbf along with the additional .prj projection file and a .txt metadata file). For more information about Export Section, click here.

IMPORT SHAPEFILES

Export Map

Operational layers can be exported from Apex in Shapefile format. This will allow you to export a single map layer in Apex.

To Export a Map Layer

1. From the Map Tree expand the Client, Farm and Field and select the operational layer you wish to export.

   NOTE: You must be in the maps window to export a map.

2. With the operational layer open in Apex, select “File > Export Map” > “Export Map.” Export map will allow you to export a single map layer.

3. The “Save As” window will appear, allowing you to select the location for the exported map to be saved.

4. Enter a unique name for the exported map in the file name box.
5. Click “Save” to export the map.

6. Apex will display a message stating the map exported successfully.

**Batch Export**

Batch Export allows you to select the following options:
- Export All
- Export Operation Data

**Export All**

1. Select “File > Export Map > Batch Export.”

2. In the “Export Options” box located in the upper left hand side of the screen select the “Export All” link.

3. In the “Export All” option Apex has an export filter above the map tree that allows you to filter the data you want to export by client, operation or boundary list.
   - If you select filter “By Operations” a second filter box will appear to the right, allowing you to filter by Application, Harvest, Seeding, Tillage, or Other.

4. In the “Export Files” window to the right you can simplify your selection by selecting “Export All” or “Export Selected.”
   - Select “Export All” if you wish to export all maps available.
   - Select “Export Selected” to select the specific data you wish to export.

5. If you select “Export All” proceed to step 7. If you select “Export Selected” proceed with the next step.

6. Apex gives you two Export Options.
   - Zipped – When checked, Apex will compress your exported data in a .zip file format.
   - Calibrate Data – When checked, Apex will export the calibrated data. If this box is unchecked Apex will export the raw data.

7. In the “Export File Types” box select “CSV or Shape” file format.
   - CSV File – Text file format that contains comma-delimited values.
   - Shape File – ESRI standard format file with point, polygon and lines to display a Geographic Information System map.

8. In the “Save To Folder” box click on the “Ellipsis” button to select the location for the data to be saved.

9. Select the location for your data to be saved and select “OK.”

10. Select “Export” to export your data.

**Export Operation Data**

Every time you make changes to the setup section, you need to save the data to your Card. Doing so provides up-to-date pick lists in the GreenStar System.

**Save data to the Card:**

1. Place the Card in the card reader.

2. Select “File > Save to Card” or select the “Save” icon.

3. On the left side, under “Card Display Options”, select the correct drive letter, and check the box for the corresponding GreenStar System (the drive letter and Display checkbox are now grouped together). If you are unsure
of the correct drive letter you can verify your drives by going to “My Computer.” If you are saving data for the GS2 1800 Display, Apex will display a list of available profiles after the card path is selected. Select the appropriate profile or click “New” to create a new profile.

NOTE: The drive selection drop down will no longer default to the C:\ drive. Users must select a drive before saving to the card. The C:\ drive will still be an option in the drop down.

Note: If you are saving setup to the Original GreenStar System for Combine Yield Mapping you will need to specify a single client to save to the card. Select the Original GreenStar System from the available displays, the “Card Format” section will open, select “Yes”, then select the “Client” you wish to save to the card. The client you select from the card format list will override your selections in the tree structure.

NOTE: When saving data for the GS2 1800 display, a profile must be created. The GS2 1800 can have multiple profiles with different data sets, while using the same data card. It is only possible to save Client, Farm, Field, Guidance, and Boundary information for the GS2 1800 display.

4. To save variety locator information to the card, variety locator files must be created first. To create variety locator files review the “Variety Locator” section in this chapter.

5. Select the appropriate filters in the “Filter by” drop down menu. This will allow the user to determine if aerial images, boundaries, flags, or prescriptions are saved to the card.

6. There are two windows on the main screen. On the left hand side is your entire Apex setup list with “+” and “-” buttons that will expand and collapse the list of setup. There are also boxes that need to be checked to mark what items in the setup will be saved to the Card.

Note: The following data is required to be saved to card: Client, Farm, Field, Crop, Machine, Implement and GreenStar Display(s) used. Also, Flags under Enterprise represent Flags which were unloaded from the GS2 and/or which were created in Apex. Flags under Resource are Flag names only; they do not represent spatial flags.

NOTE: Load Destinations and Names can be saved to the data card. Example: If a grower is taking all their grain to the elevator for storage, you can use all the elevators’ names or locations as the Load Destination. An example of a Load Name is the name of the driver or truck for a certain load.

7. At the bottom of the window there will be four selections:
   • Expand All will expand the entire list of setup to show everything.
   • Collapse All will do the opposite, and just show the main categories in setup.
   • Select All will mark every item in setup to be saved to the Card.
   • Clear All will uncheck all items and nothing will be saved to the Card.

8. The window on the right hand side will display every item in setup that has been selected for saving to the Card.

9. Once you verify that you are saving the correct information from setup, press the "Save to Card" button at the top right of the window.

NOTE: The “Copy to” button at the top right of the window performs the same function as the “Save to Card”.

10. A progress indicator will appear to show that setup is being saved to the Card. Once finished a message will appear stating: “Data was successfully saved to your card(s).” You will need to stop the drive that your Card is in and then you can eject the card.

NOTE: Save to Card does not append information to the card. It is necessary to select all information to be saved to the card each time a card is made.

Save to Machines or MyJohnDeere from Apex

Send setup files directly to machines or to MyJohnDeere from Apex. Follow link for more information.

Send Wireless Data Transfer Files
Save to card Templates

Apex 2.7 has added the ability to save your selected setup items as a template for quick and easy recall of what you have saved previously.

1. Select all the items you would like to save to card.
2. At the top of the screen select “new” in the drop down under templates
3. Give the selected items a name.
4. Going forward you can select that template and the setup items that were previously save will be automatically selected.

NOTE: After selecting a template you can add additional items to the template for one time use or you can resave using the same name to add items to the template permanently.

NOTE: Global Guidance Lines and Variety Locator files will not save to templates. These should be selected manually each time they are needed.

For information on saving Variety Locator files, click here.

For information on saving Guidance Tracks to your card, click here.

Unload

During the unload procedure, the raw data is converted, adjustments from the preferences settings are made, and new files are created for the maps. The raw files are automatically copied to an archive directory on your computer’s hard drive.

Prior to unloading the Card, you must first make updates to your preferences to utilize the file processing delay functionality or the data will not reflect the delay settings for your implement or combine.

NOTE: In preferences, Apex now allows split operations to be unloaded. Refer to Preferences for additional information.

Unload Setup Data:

Setup data can be unloaded by using the Card or archive files. Setup data contains all information regarding the setup screen (Client, Farm, Field, Task, flags, and so on.)

NOTE: Unloading setup data WILL NOT unload maps or any other information.

Also setup data can be used and unloaded across multiple computers which have Apex installed.

Unload data from the Card:

1. Place the Card in the card reader.
2. Select “File > Unload” or select the “Upload” icon from the Navigation Bar.
3. On the left side, in the “Card Options” section, select the correct drive letter for the corresponding GreenStar™ System. (If you are unsure of the correct drive letter, you can verify your drives by going to “My Computer.”) If you are unloading data from the GS2 1800 display, Apex will display a list of available profiles after the card path is selected. Select the appropriate profile from the drop down box.
4. After the correct drive is selected all recorded data that is on the card will be listed in the main window according to the client, farm, field, and task. Each file in the main window has a box that needs to be checked to signify that you
want to have it unloaded. To simplify the selection, there are two buttons at the top of the window that will allow you to “Select All” or “Clear All” this will check or uncheck every file.

5. You can unload the following data: Setup data, Operational data, Flags, Guidance tracks which include A/B lines, A/B curves, Curved track lines and Circle tracks.
• If you have multiple GreenStar Systems, data will be listed separately according to each system.

6. After you have checked the data that you want to unload, press the “Unload” button in the top right corner of the window. Each file will have a progress indicator and will be labeled successful when it has been brought into Apex.

Unload Files from Machine of Shared to MyJohnDeere

Unload documentation files wirelessly transferred from machines or shared to a MyJohnDeere organization. Follow the link for more information.

Unload Wireless Data Transfer Files

Clean Card

Manage Archive

Transfer

Activate Wireless Data Transfer service within Apex to communicate with Wireless Data Transfer enabled machines and MyJohnDeere Organizations. Follow the link for more information.

Clean Card

As a built-in protection, the Clean Card window will only show processed files and none of the processed data on the hard drive will be affected.

Clean data from the Card:

1. Place the Card in the card reader.

2. Select “File > Clean Card.”

3. On the left hand side in the Card Options window, select the correct drive letter for where your card is inserted (if you are unsure of the correct drive letter you can verify your drives by going to My Computer).
• This will display all data that is currently saved to the card. The data will be displayed in the main window according to the Client, Farm, Field, and Task. Each file in the main window contains a box that needs to be checked to signify that you want to remove it from the Card. To simplify the selection, there are two buttons at the top of the window that will allow you to “Select All” or “Clear All” which will check or uncheck every file.
• If you have multiple GreenStar Systems, data will be listed separately according to each system.

4. After you have checked the data that you want to have removed from the Card, press the “Clean” button located in the top right hand corner of the window.

5. A popup box will appear, “Do you want to backup data to hard disk before clearing the card.”
• If “Yes” is selected, select “Browse” and select a desired location to save data then select “OK”.
• If “No” is selected the clean card process will begin.
6. Each file will have a progress indicator and will be labeled removed when it has been taken off of the Card.

NOTE: As a built-in protection, the Clean Card window will only show processed files and none of the unprocessed data on the hard drive will be affected.

A Best Practice is to make a backup of the entire data card saved onto the computer, CD, or DVD prior to performing the Clean Card function.
Summary Reports

All of the data collected during field operations can be viewed in at least one of the summary reports. The reports are in a spreadsheet format and are designed to have summaries which answer the most frequently asked questions about an operation.

View a Summary Report:

1. From the "Home" page, click on the "Reports" icon or select the "Reports" option from the top left on the Apex window.

2. The "Preferences" window will appear.

3. Expand the "Enterprise" check box and select the "Client," Farm," Field," and a "Year or Date Range." This is the information that will appear on the report.

4. After setting up the preferences, click on the type of report you want to view by selecting the appropriate report type from the left hand side of the screen. This will prompt the report generation box and the report will be generated.

5. All reports can be printed by selecting the " Print" button at the bottom of each report screen. Click " Export" to save the data as a file for use in other software products. Another option is the "Page View" which will allow you to view your reports in a Single Page, Side by Side, or Multi-Page Layout.

Types of Summary Reports Available:

SEEDING REPORT
APPLICATION REPORT
HARVEST REPORT
TILLAGE REPORT
OTHER REPORT(S)
JDRP REPORTS

User Preferences

Preferences

Apex gives you the ability to customize your reports. Select the "Client," "Farm," "Field," and a "Year or Date Range" and only this information will appear on the report.
The Seeding Summary Report will list the variety that was planted as well as the area in acres. After the area, the next two columns are the average rate applied and the total amount applied. This information will appear for the clients, farms, and fields you specified under preferences.

1. Select “Reports > Seeding > Seeding Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Seeding Field Summary Report**

The Seeding Field Summary summarizes the seeding operations for the selected client, farm, and field. The report includes the basic client information along with FSA numbers, task, crop, and variety.

The next section of this report is the task summary. The area, amount applied, productivity (area/hour), minimum and maximum rate are listed for the field.

The last section of this report will list the field and weather conditions. This information will only appear if it was entered in the display at the time of the operation.

1. Select “Reports > Seeding > Field Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Application Reports**

**Application Summary**

The Application Summary summarizes the product applied, average rates, total amounts applied, and area for each farm and field you selected under preferences. If more than one product was applied in a field, each additional product will appear on a separate line listing the average rates, total amounts applied and area.

1. Select “Reports > Product Application > Application Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Application Field Summary**

The Application Field Summary is a summation of the product application (chemicals) operations used for each farm and field you selected under preferences.

The top of the report will list the client information and resource summary (client, farm, field, FSA numbers, task, date, crop, and operator). If the field has a boundary created, it will show in the window to the right. The next section lists the product information summary which consists of the products, area, average rate and total amount applied. EPA
Registration numbers, if entered into Apex, will show after each chemical. The bottom of the section will show the total time, productivity (area/hour) and depth/height.

The last two sections of this report will provide weather conditions (wind speed, wind direction, air temperature, relative humidity), and field conditions (soil condition, soil temperature) as entered into the display in the machine at the time of application.

1. Select “Reports > Product Application > Field Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

---

**Harvest Reports**

**Harvest Summary**

The Harvest Summary reports display the yield results for each farm and field you selected under preferences. This report lists the farm, field, and crop. For each crop, area harvested, average moisture, wet weight, dry weight, average weight, dry volume and average yield will be listed. There is a total line at the end of the report which is a summary of all the farms totals.

1. Select “Reports > Harvest > Harvest Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Harvest Field Summary**

The Harvest Field Summary report summarizes the harvest results for each farm and field selected under preferences. This report will include client information (client, farm, field, task and start date). The resource summary section will include (crop, area and operator). Variety info section includes (variety name). The grain info section will show (number of loads, average yield, moisture, weights, productivity (area/hour)). Weather conditions section will show (wind speed, wind direction, air temperature, relative humidity), and the field conditions section shows the (soil condition, soil temperature).

**NOTE:** Weather and field conditions will only be listed if they were entered into the display in the machine at the time of harvesting.

1. Select “Reports > Harvest > Field Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Variety Summary**
This report shows all the varieties harvested for each farm and field selected under preferences. For each variety, it will list the area, average dry yield, moisture and average wet weight.

1. Select “Reports > Harvest > Variety Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

Date Summary

The Harvest Date Summary lists the date the field was harvested for each farm and field selected under preferences. It will also list the crop, brand, variety, area, average dry yield, moisture, and average wet yield for each field.

1. Select “Reports > Harvest > Date Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

Load Detail Summary

The Load Detail Summary summarizes load information for each farm and field selected under preferences. The report will list the crop and then the loads for that crop. Loads will be sorted by load name, load number and will also show brand, variety, area, average moisture, average yield, total dry weight, dry volume and Destination. The last line of each field provides a summary for all loads.

1. Select “Reports > Harvest > Load Detail Summary.”

2. Set the filters to generate a Load Detail Summary Report:
   a. Select from following Harvest Types: Cotton, Forage, Grain or All
   b. Once harvest type is selected load name, load number and load destination will be filtered accordingly for the selected harvest type. You can set these filters according to your report needs or click “All”
   Note: Harvest Type filter can also be fixed from Maps Preference Page under Reports. For more information on Report Preferences, click here.
   c. Click “Continue” to generate report. Clicking “Cancel” will abort the report generation. To re-generate the report click Load detail summary report again.

3. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

4. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

Scale Ticket Summary

The Scale Ticket Summary will give you a summation of the scale tickets that were entered from the post calibration page. This report will show the client, farm field, crop, moisture, weight and year. Additionally it will show the ticket ID, weight, moisture, and foreign material for each scale ticket that you entered.

1. Select “Reports > Harvest > Scale Ticket Summary.” This will generate the report and display it in the window to the right.
2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

---

**Summary**

The Tillage Summary report summarizes the tillage operations performed for each farm and field selected under preferences. For each field, the number of acres that were tilled will be listed. The last column will list the average depth of the tillage practice. Subtotals will be listed at the bottom of the last page.

1. Select “Reports > Tillage > Tillage Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Field Summary**

The Tillage Field Summary summarizes the tillage results for each farm and field selected under preferences. This report will include client details, summary of the tillage operation, and weather conditions.

The client information section will list the client, farm, and field as well as the task, FSA numbers, and operator. In the upper right section of the client information will be the field boundary of the field.

The summary section provides the area, depth, time, and productivity.

The last section includes the weather conditions which were entered into the display by the operator.

1. Select “Reports > Tillage > Field Summary.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in.
   • “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

---

**Other Reports**

**Task Detail**

The Task Detail report is a summation of all of the field documentation which was recorded for all tasks for each farm and field selected under preferences.
The top portion of this report will display the client information (Client, Farm, Field, Task, Date, and Year). Next, it will list all the operations performed for that field.

1. Select “Reports > Other > Task Detail.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown arrow to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**JDRP Reports**

The John Deere Risk Protection tracking information report will allow you to report the crop insurance information for each specific field.

**Set Up JDRP Report**

1. Select “Setup > Enterprise > “Field.”

2. From the existing fields list choose the field in which you would like to enter in the crop insurance information, then click “Modify.”
   - If field does not exist select the “New” button and create a new field.

3. Enter all crop insurance information.
   - Policy number
   - Unit number
   - Type - name of crop
   - Practice - irrigated or non-irrigated

4. Once you have entered your appropriate information click “Update” and you will be ready to generate your JDRP Reports.

**Acreage Report**

The Acreage Report will display planting information based from the Crop Insurance and FSA information that is entered in the Field setup. The report will be sorted by Policy Number, then Unit Number, and then FSA Field ID. The crop, type, practice, planted acres, and plant date will be displayed. Each Unit will also be summarized with totals for all fields.

1. Select “Reports > JDRP Reports > Acreage Report.” This will generate the report and display it in the window to the right.

2. To print your report, click the “Print” icon at the bottom of the window to get a hard copy of the data.

3. To export your report, click the “Export” dropdown tab to select the format you wish to export the data in. “Page View” will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

**Production Report**

The Production Report will display yield information based from the Crop Insurance information that is entered in the Field setup. The report will be sorted by Policy Number and then Unit Number with each field on one line. The crop, type, practice, acres, moisture, wet weight, dry weight, total production, and average yield will be displayed. Each Unit will also be summarized with totals for all fields.
1. Select “**Reports > JDRP Reports > Production Report.**” This will generate the report and display it in the window to the right.

2. To print your report, click the **“Print” icon** at the bottom of the window to get a hard copy of the data.

3. To export your report, click the **“Export” dropdown arrow** to select the format you wish to export the data in.
   - **“Page View”** will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.

---

**Guidance Reports**

The Guidance Reports allow you to show and print out lists of your guidance lines with the latitude and longitude information for the lines selected. This can include lat/long of A and B points heading degrees track spacing.

1. Select **“Reports > Guidance Reports > select the report you would like to see.”** This will generate the report and display it in the window to the right.

2. To print your report, click the **“Print” icon** at the bottom of the window to get a hard copy of the data.

3. To export your report, click the **“Export” drop down arrow** to select the format to export the data in.

4. **“Page View”** will allow you to select how many reports you would like to view on one page. This will work when you have multiple pages for one report.
Map Tools

Map Tree Filter

You can use these filters to hide or show the data that you want to be displayed in the map tree. For example, if you choose crop season 2007 then only data for that season will be displayed in the map tree.

You will have three options to filter by:
- Field
- Map
- Crop Season

Map Tree and Right Click Options

The Map Tree gives you the ability to view multiple clients, farms, fields, and map layers. Clicking on the different available maps displays the specific map layer you selected in the Map Viewing Area. The following layers will be viewable in the map tree: “Operational layers, Flags, Guidance tracks, Aerial Image, Boundary and Management Zones.”

Right Click Options on Map Tree

These options are available when you right click on a node in the map tree. Not all options are available for all layers.

Create New Map - Use this option to open a new map layer in a new Map Viewing Area.
1. From the map tree right mouse click on the map layer to be opened.
2. Select “Create New Map.”
3. Apex will display the map layer in the Map Viewing Area and add to the Map Layers Window.

Add to Current Map - Use this option to add a map layer to the current Map Viewing Area.
1. From the map tree right mouse click on the map layer to be added.
2. Select “Add to Current Map.”
3. Apex will display the selected map layer in the current Map Viewing Area and add the map layer to the top of the Map Layers Window.

Add to Map - Use this option to add a map layer to a specific Map Viewing Area when multiple Map Viewing Areas are open.
1. From the map tree right mouse click on the map to be opened.
2. Select “Add to Map.”
3. Apex will display the names of all Map Viewing Areas. Names of the Map Viewing Areas correspond to the active map layer name for that window.
4. Select the Map Viewing Area the map layer should be added to.
5. Apex will add the selected map layer in the selected Map Viewing Area and Map Layers Window.

EDIT OPTIONS
Maps Layers Window

Once you select a map from the map tree, it will be added to the map viewing area and to the map layers window. This feature will allow you to layer all your maps, adjust transparency and move your map layers up or down. The active map layer is the layer which is highlighted. You can view any map layers functional area by selecting that map from the map layers window that you want to view. Un-checking the box will hide the map layer from the map viewing area.

Layering tools are available below the Map Layers Window. These tools will allow you to mange your map layers in the Map Layers Window. These tools will do the following:

- Move the active layer up one level.
- Move the active layer down one level.
- Remove the active layer from the view.
- Show full extent of the active map layer.
- Generate a composite map.

The Map Layers Window allows you to layer multiple map layers in a single Map Viewing Area. The tools located beneath the Map Layers Window adjust the transparency of a map layer, move map layers up or down in the Map Layers Window to determine display order, remove map layers from the Map Layers Window and Map Viewing Area, and generate a composite map from two or more map layers.

Map layers are added to the Map Layers Window and Map Viewing Area when they are selected in the Map Tree. The drawing order of the map layers can be changed by using the “Move the active layer up one level” or “Move the active layer down one level” tools below the Map Layers Window. To zoom to the extent of a map layer, select the map layer to make it active and click the “Show full extent of the active map layer” tool beneath the Map Layers Window.

The transparency of any map layer can be adjusted by selecting the map layer in the Map Layers window to make it active. Then, use the Transparency slider bar beneath the Map Layers Window to adjust the transparency. The transparency of a map layer is retained until it is adjusted again. If a map layer is not displaying in the Map Viewing Area, check the transparency to ensure the map layer is not set to be invisible.

A map layer in the Map Viewing Area can be turned on and off by checking and un-checking the box in front of the map layer in the Map Layers Window. When the box is checked the map layer will be displayed in the Map Viewing Area. When unchecked the map layer will be off and not display in the Map Viewing Area. Un-checking the box does not remove the map layer from the Map Viewing Area and Map Layers Window. To remove a map layer from the Map Viewing Area and Map Layers Window, click on the map layer in the Map Layers Window to make it active and select the “Remove the active layer from the Map Viewing Area” tool below the Map Layers Window.

To create a composite map turn on two or more Operational map layers of the same attribute and click the “Generate a composite map” tool beneath the Map Layers Window.

For more details regarding composite maps, click here.

Map Viewing Area

The Map Viewing Area is where the field’s collected and imported maps (i.e. shapefiles) along with guidance tracks and flags are geographically displayed within Apex. At the top of the Map Viewing Area there will be buttons associated to the map you are view if you have multiple map pages open.

At the top of the Map Viewing Area, are tabs displaying the name of the active map layer in the Map Viewing Area. Selecting a tab opens the Map Viewing Area to the previous viewing extent. The “New” tab displays a blank Map Viewing Area where additional map layers can be added.
To add a map layer to the Map Viewing Area, select a map layer in the Map Tree. The map layer will appear in the Map Viewing Area and the tab will be named according to the map layer selected. Selecting additional map layers will add them to the active Map Viewing Area. The drawing order of the map layers can be changed by using the “Move the active layer up one level” or “Move the active layer down one level” tools below the Map Layers Window.

NOTE: Map layers can be displayed in multiple Map Viewing Areas.

To display a map layer in a new Map Viewing Area, you have two options:
• Select the “New” tab and then select the map layer from the map tree to be open.
• Right click on the map layer you want to display in the Map Tree and select “Create New Map” or “Add to Map > New.”

Maps Functional Area

The Functional Area of the map section provides functionality to view and edit the legend, view summary information, create additional map layers, or edit properties for the active map layer in tabs labeled Legend, Summary, Create, and Edit. Not all functionality is available for all map layers so not all tabs will be displayed for every layer.

Functional areas include:
Legend
Summary
Create
Edit

Depending on which map layer is active, functional areas will be displayed accordingly.

Map Tools

Command Tools

The command tools allow you to view and manage the current map you are viewing. Specific command tools are only available when viewing specific maps.

FULL EXTENT
SELECT
ZOOM IN
ZOOM OUT
PAN
CONTOUR MAP TOOL
PRINT MAP
SPLIT MAPS
PRINT MAP (Single Map View)
RULER
RECTANGLE SELECTION
POLYGON SELECTION
ATTRIBUTE SELECTION

Full Extent Tool

The Full Extent tool will redraw the entire map on the screen without any magnification. The tool will perform the same function regardless if you are on a farm or field map.
Select Tool

On the farm map, the Select tool is used to pick a field.

On the farm map, the Select tool is used to pick a field. On the field map, the select tool is used to create boundaries in the boundary editor tab.

Zoom In Tool

The Zoom In tool is used to enlarge the map. The area you click on will be the area that is enlarged. You can also magnify a rectangular area by dragging the mouse across a specific area while depressing the mouse button.

For greater accuracy, you may want to zoom in when adjusting boundary points, prescription polygons, etc.

Zoom Out Tool

The Zoom Out tool is used to reduce the size of the map. The area you click on will be the area that is reduced in size.

Pan Tool

The Pan tool is used in lieu of the scroll bars to adjust the location of the map within the map viewing area. Position the hand over the map and depress the left mouse button; move the mouse to move the map. Release the left mouse button when you are done moving the map.

Contour Map Tool
A contour map (topographic map) uses contour lines (often called a "contour") to join points of equal elevation (height) or within a given range and thus show valleys and hills, and the steepness of slopes.

You can convert an operational layer to a contour map which can then be used to create a prescription.

1. Open an operational layer using the map tree.
2. Adjust your map legend (optional).
3. Click on the “Contour Map” tool. Do not click on the down arrow.
4. Your map will be converted into a contour map. If you wish to go back to your original map then click on the "Contour Map" tool again.
   • NOTE: This map can be used to create a prescription.
   • Refer to Create Prescription using a Contour Map for more information.

Advanced Options
The advanced dropdown box on the “Contour Map” tool allows you to adjust settings that control how a contour layer is generated. To access these options, click on the down arrow and select “Advance Options.”

The contour layer is created by utilizing the Inverse Distance Weighted algorithm to generate a continuous raster surface from point data (GPS locations). IDW works by using neighboring data points (within a search radius) to estimate values in a new raster image. This raster is made up of cells (pixels) aligned in rows and columns that form a continuous surface, therefore eliminating the appearance of gaps between GPS point locations.
Contour Layer (Smooth Surface)

Settings in the Advanced Options window allow you to adjust parameters in the IDW algorithm that determine the smoothness of the resulting map. You have the opportunity to adjust the following three input parameters:

Cell Size – The size (in units selected) of each pixel in the resulting map (raster image).

Maximum Search Radius – The distance (radius of a circle) that will be used to identify the points included in the calculation for each interpolated raster cell.

Power – The power parameter determines the weight assigned to neighboring points based on the distance from the interpolated cell. Typical values range from 0.5 to 3.
• A higher power (2-3) will give nearby points more influence and the surface will have more detail (less smooth surface).
• A lower power (0.5-2) will give a higher weight to points further away and the surface will have less detail (more smooth surface)

Grid – If you uncheck the “Contour” check box then the map will be converted into a grid map.

NOTE: The values you entered will not be remembered once you generate a contour map. If you readjust your legend then Apex will create the contour map based on default settings. It is advised to modify the legend before you create a contour map. Once you close the contour map the contour map will not be saved. You will have to regenerate the contour map again.

Print Map Tool

Client, Farm and Field layer maps can be printed from the “Print” tool. To be able to print a layer, the layer must be displayed in the map view.

Print tool will print what you are viewing in the map view. If you are zoomed into a map, Apex will print the zoomed in view.

Split Map

Apex gives you the ability to view up to four maps at one time within the Mapping area. You can split the screen horizontally, vertically or both.
**Ruler Tool**

The **Ruler tool** gives you the ability to measure distance in the map view.

**To Measure Distance:**

1. Select the layer you wish to view to measure a distance.
2. Select the "**Ruler**" tool.
3. Click on the map to select the starting point.
4. Move the ruler point to the ending point.
   
   **Note:** The distance will be displayed next to the Ruler tool icon.
5. To disable the ruler tool, click on the map.

**Rectangle Selection Tool**

The Rectangle Selection Tool has two functions:

- Display a Descriptive Summary for Selected Area.
- Remove Geospatial Data Points

**Delete Points:**

1. Select the map layer you wish to remove the data points from the available maps area.
2. Click on the **"Rectangle Selection" tool**.
3. Click and drag to encompass the data points you wish to delete.
4. Click the **"Delete Points" tool**.
5. Select **"OK"** to delete the points or **"Cancel"** to not delete the points.

**NOTE:** The deletion of points is permanent. The only way to bring them back is to re-unload the raw data back into Apex.

**Display Descriptive Summary for Selected Area:**

The Rectangle Selection tool can be used to see field statistics for a rectangular area.

Each time you draw a new rectangle, the data in the "Selection Summary" window will change. The area reported is the machined area within the rectangle, as determined from the point data. To see data about the whole field, draw a rectangle that includes all the data sites.
View information for a rectangular area:

1. Select the map layer you wish to view information for.
2. Click on the "Rectangle Selection" tool.
3. Click and drag to encompass the data points you wish to view information for.
4. Select the "Display Descriptive Summary for Selected Area" tool to view the information within your rectangle (blue icon with the letter i in the center).
5. A "Selection Summary" window will appear with information for the selected points.
6. You can use the "Print" icon in the "Selection Summary" window to print a summary of the information. The print feature will take you to the reports screen and display a print summary report. You can navigate back to maps area at any time by selecting the "Maps" icon.
7. Close the "Selection Summary" window when finished.
8. To remove the rectangle from the map click the “Cancel” button.

Rectangle Tool for use with Prescriptions

The Rectangle tool is used to draw rectangular polygons for a prescription map.

To draw a rectangle:

1. Select the "Rectangle Tool."

2. Click and hold down on the right mouse button while dragging the mouse to form a rectangle. Release the mouse button when the rectangle is the size you want.
   • You can resize the rectangle by selecting one of the points and dragging it to minimize or maximize the size.
   • Click and hold in the rectangle to move the rectangle to a different location on the map.
   • To delete the shape, select the shape you want to delete. Right click with your mouse and choose “Delete Selection.”

Polygon Tool

The Polygon Selection Tool has two functions:
   • Display Descriptive Summary for Selected Area
   • Remove Geospatial Data Points

Delete Points:

1. Open the map layer you would like to remove the data points from.
2. Click on the "Polygon Selection" tool.
3. Click on the map to encompass the data points you wish to delete and select at least three points.
4. Click the “Delete Points” tool.
5. Select “OK” to delete the points or “Cancel” to not delete the points.

NOTE: The deletion of points is permanent. The only way to bring them back is to re-unload the raw data back into Apex.

Display Descriptive Summary for Selected Area:
The Polygon Selection Tool can be used to see the field statistics for a manually drawn irregular-shaped polygon area.

Each time you draw a new polygon, the data in the Selection Summary window will change. The area reported is the machined area within the polygon as determined from the point data.

**View information for a manually drawn polygon area:**

1. Select the map layer you wish to view information for data points from the available maps area.
2. Click on the “Polygon Selection” tool.
3. Click and drag to encompass the data points you wish to view information about.
4. Click the “Display descriptive summary for selected area” tool to view the information within your polygon.
5. A “Selection Summary” window will appear with the information for the selected points.
6. You can use the "Print" icon in the “Selection Summary” window to print a summary of the information. The print feature will take you to the reports screen and display a print summary report. You can navigate back to maps area at any time by selecting the “Maps” icon.
7. Close the “Selection Summary” window when finished.
8. To remove the polygon from the map click the “Cancel” button.

**Use With Prescriptions**

The Polygon tool is used to draw an irregular-shaped polygon on a prescription map.

To draw an irregular-shaped polygon:

1. Select the “Polygon tool.”
2. Start by clicking on the map to create an anchor point (this point will be the start and end point of your polygon). Then move the mouse to the next location and click again. A line will be drawn between the two points. Continue doing this until you have the shape you desire.
3. To close the polygon, select the selector tool from the tool bar.
   • You can resize the polygon by selecting one of the points and dragging it to minimize or maximize the size.
   • Click and hold in the polygon to move the polygon to a different location on the map.
   • To delete the shape, select the shape you want to delete. Right click with your mouse and choose “Delete Selection.”

**Attribute Selection**

The Attribute Selection Tool enables a user to specify a condition based on an attribute to identify a map area on which you want to perform certain operations for example a descriptive summary, operators, machines, specific yield values.
To use the Attribute Selection Tool

1. Click on the "Select by Attribute" icon at the top of the screen and the "Select by Attribute" window will appear.

2. Use the drop down menu to specify each parameter to be identified, and then select “Done.”
   • To further define your search criteria click the “Advanced” button and select the information that you want to use to further define your search.

3. The map will display the areas identified in a grey color.

4. To view the information that you defined above, select the “Display descriptive summary for selected area” icon.

5. You can use the "Print" icon in the “Selection Summary” window to print a summary of the information. The print feature will take you to the reports screen and display a print summary report. You can navigate back to maps area at any time by selecting the “Maps” icon.

6. Close the “Selection Summary” window when finished.

7. To undo the selection from the map click the “Cancel” button.

Note: Use the “Select by Attribute” tool to select load number, name or destination. Once the data is selected, use the “Display descriptive summary for selected area” to display a summary from the selected data.
The **Maps icon** allows the user to graphically view the collected field data, create prescriptions, edit setup information, and create guidance A/B tracks.

The map screen has the following areas:

For more information on each of these areas, click on any of the following links:

- Available Maps Area
- Map Tree
- Map Layers Window
- Map Viewing Area
- Functional Area
- Map Tools
- Filter
Select the “File > Preferences > Maps.”

**Select Area for Printed Maps**

Area to use on printed maps – Apex is capable of displaying three different areas for your fields. However, only one area type can be selected at a time. This will give you the option of which area you would like to see on the printed field maps.

1. The **Area of field** is the number of acres that are legally listed on the government land registration documents. Apex uses this as the default setting.

2. The **FSA Area of field** is the number of acres of cropland that meets the requirements of FSA payment programs for crops such as wheat, corn, soybeans, and cotton.

3. The **Machine area of field** is the area calculated from the data gathered by the GreenStar Display. (Default)

The user enters both the Area of field and the FSA Area of field values under “Setup > Enterprise > Field” for each field in the farming operation. Both of these values are usually larger than the machine area, as these are the areas of the entire plot of land, not just the area that the equipment has covered while in the field.

**Normalization Procedure**

The process of reassigning the values in a data set to a fixed or common scale. Apex will normalize operational layers through the legend panel depending on what procedure is selected. The original attributes values are re-scaled based on which normalization method you select.

1. **Standard Normal** = (value – mean) / standard deviation: Standard Normal procedure results in a data layer containing values having a mean of 0 and approximate range from negative 3 to positive 3. Standard Normal procedure is one the most robust normalization procedures and therefore set as the default.

2. **Mean Adjusted** = (value / mean) * 100: Mean Adjusted procedure results in a data layer containing values having a mean of 100 and units expressed as percentages. This procedure is widely used but not as robust as Standard Normal because percentages can vary greatly depending range of values relative to the mean.

3. **Relative Adjusted** = (value – minimum) / (maximum – minimum) *100: The Relative Adjusted procedure results in a data layer containing values having an approximate mean of 50 and a precise range from 0 to 100. The units are expressed as percentages. This procedure is not as robust as the Standard Normal because it is greatly influenced by extreme values.

Standard Normal
For more information on Normalization, click here.

**Draw Points in Reverse on Layer Maps**

When the "Draw points in reverse" box is **not** checked, the area covered first will be covered up by subsequent trips. If the "Draw points in reverse" box **is** checked, the area covered first will show on top of the map (it will cover up any area that was previously covered).

**Merge**

This will allow you to set a limit when merging the following:

1. Client – Default is set to 25 miles (English units of measurement), however, you can specify a different value. This limit will be checked by Apex when merging two clients.

2. Farm – Default is set to 25 miles (English units of measurement), however, you can specify a different value. This limit will be checked by Apex when merging two farms.

3. Field – Default is set to 2 miles (English units of measurement), however, you can specify a different value. This limit will be checked by Apex when merging two fields.

**NOTE:** Please refer to Right Click Options in Maps topic for more information.

These preferences **will be saved when you close and re-open Apex.**

**Composite Map Settings**

The composite maps function in Apex allows you to combine multiple data layers for the same field and generate a new aggregate layer with the input information. During the composite process, Apex first automatically filters the selected data layers to eliminate extremely high and low values using a standard deviation threshold (+/- 3 STDev from the Mean). You also have the option to set additional filters on data that you do not want included in the composite routine (see examples to the right). You have the option to set a filter on the following criteria:

- Mass Yield Filter Defaults: Set minimum and maximum filters based on yield mass (ie, lbs/ac); and/or
- Volume Yield Filter Defaults: Set minimum and maximum filters based on yield volume (ie, bu/ac); and/or
Apex User Guide

• Bale Yield Filter Defaults: If you are using cotton data, set minimum and maximum filters based on bale yield (bales/ac); and/or
• Elevation Filter Defaults: Set minimum and maximum filters based on elevation (units based on your General Preferences setting – English: feet, Metric: meters)

NOTE: Please refer to Composite Maps in Maps topic for more information.

Available Maps Area

Available Maps Filters

Filter by:

Field: Joe Farmer - Farm 1 - 1 - Farm
Map: Harvest
Crop Season: 2007

Three map filters are available in Apex. You can select any of these filters to sort the data in your map tree. This allows you to view only the information that you want to see in your map tree.

Field: Displays layers for the selected “Client, Farm and Field.” By default all boxes will be checked. Uncheck the “Client(s), Farm(s), or Field(s)” you do not want to view in the map tree, click out of the box to close the drop down box. The map tree will be filtered with the selected “Client, Farm and Field.”

Map: Displays layers of the selected map type. Uncheck the layer types you do not wish to view in the map tree, click outside of the box to close the drop down box. The map tree will be filtered with the selected maps.

Crop Season: Displays layer for the selected season(s). Uncheck the season(s) you do not wish to view in the map tree, click outside of the box to close the drop down box. The map tree will be filtered with the selected maps.

NOTE: These filters will be retained the next time you open Apex.

Map Viewing Area

The Map Viewing Area is where the field’s collected and imported maps (i.e. shapefiles) along with guidance tracks and flags are geographically displayed within Apex. At the top of the Map Viewing Area there will be buttons associated to the map you are view if you have multiple map pages open.

At the top of the Map Viewing Area, are tabs displaying the name of the active map layer in the Map Viewing Area. Selecting a tab opens the Map Viewing Area to the previous viewing extent. The “New” tab displays a blank Map Viewing Area where additional map layers can be added.

To add a map layer to the Map Viewing Area, select a map layer in the Map Tree. The map layer will appear in the Map Viewing Area and the tab will be named according to the map layer selected. Selecting additional map layers will add them to the active Map Viewing Area. The drawing order of the map layers can be changed by using the “Move the active layer up one level” or “Move the active layer down one level” tools below the Map Layers Window.

NOTE: Map layers can be displayed in multiple Map Viewing Areas.

To display a map layer in a new Map Viewing Area, you have two options:
• Select the “New” tab and then select the map layer from the map tree to be open.
• Right click on the map layer you want to display in the Map Tree and select “Create New Map” or “Add to Map > New.”
Maps Layers Window

Once you select a map from the map tree, it will be added to the map viewing area and to the map layers window. This feature will allow you to layer all your maps, adjust transparency and move your map layers up or down. The active map layer is the layer which is highlighted. You can view any map layers functional area by selecting that map from the map layers window that you want to view. Un-checking the box will hide the map layer from the map viewing area.

Layering tools are available below the Map Layers Window. These tools will allow you to mange your map layers in the Map Layers Window. These tools will do the following:

- Move the active layer up one level.
- Move the active layer down one level.
- Remove the active layer from the view.
- Show full extent of the active map layer.
- Generate a composite map.

The Map Layers Window allows you to layer multiple map layers in a single Map Viewing Area. The tools located beneath the Map Layers Window adjust the transparency of a map layer, move map layers up or down in the Map Layers Window to determine display order, remove map layers from the Map Layers Window and Map Viewing Area, and generate a composite map from two or more map layers.

Map layers are added to the Map Layers Window and Map Viewing Area when they are selected in the Map Tree. The drawing order of the map layers can be changed by using the “Move the active layer up one level” or “Move the active layer down one level” tools below the Map Layers Window. To zoom to the extent of a map layer, select the map layer to make it active and click the “Show full extent of the active map layer” tool beneath the Map Layers Window.

The transparency of any map layer can be adjusted by selecting the map layer in the Map Layers window to make it active. Then, use the Transparency slider bar beneath the Map Layers Window to adjust the transparency. The transparency of a map layer is retained until it is adjusted again. If a map layer is not displaying in the Map Viewing Area, check the transparency to ensure the map layer is not set to be invisible.

A map layer in the Map Viewing Area can be turned on and off by checking and un-checking the box in front of the map layer in the Map Layers Window. When the box is checked the map layer will be displayed in the Map Viewing Area. When unchecked the map layer will be off and not display in the Map Viewing Area. Un-checking the box does not remove the map layer from the Map Viewing Area and Map Layers Window. To remove a map layer from the Map Viewing Area and Map Layers Window, click on the map layer in the Map Layers Window to make it active and select the “Remove the active layer from the Map Viewing Area” tool below the Map Layers Window.

To create a composite map turn on two or more Operational map layers of the same attribute and click the “Generate a composite map” tool beneath the Map Layers Window.

For more details regarding composite maps, click here.

Maps Functional Area

The Functional Area of the map section provides functionality to view and edit the legend, view summary information, create additional map layers, or edit properties for the active map layer in tabs labeled Legend, Summary, Create, and Edit. Not all functionality is available for all map layers so not all tabs will be displayed for every layer.

Functional areas include:

Legend
Summary
Depending on which map layer is active, functional areas will be displayed accordingly.

## Export Map

Operational layers can be exported from Apex in Shapefile format. This will allow you to export a single map layer in Apex.

### To Export a Map Layer

1. From the Map Tree expand the Client, Farm and Field and select the operational layer you wish to export.

   **NOTE:** You must be in the maps window to export a map.

2. With the operational layer open in Apex, select “File > Export Map” > “Export Map.” Export map will allow you to export a single map layer.

3. The “Save As” window will appear, allowing you to select the location for the exported map to be saved.

4. Enter a unique name for the exported map in the file name box.

5. Click “Save” to export the map.

6. Apex will display a message stating the map exported successfully.

### Batch Export

Batch Export allows you to select the following options:
- Export All
- Export Operation Data

#### Export All

1. Select “File > Export Map > Batch Export.”

2. In the “Export Options” box located in the upper left hand side of the screen select the “Export All” link.

3. In the “Export All” option Apex has an export filter above the map tree that allows you to filter the data you want to export by client, operation or boundary list.
   - If you select filter “By Operations” a second filter box will appear to the right, allowing you to filter by Application, Harvest, Seeding, Tillage, or Other.

4. In the “Export Files” window to the right you can simplify your selection by selecting “Export All” or “Export Selected.”
   - Select “Export All” if you wish to export all maps available.
   - Select “Export Selected” to select the specific data you wish to export.

5. If you select “Export All” proceed to step 7. If you select “Export Selected” proceed with the next step.

6. Apex gives you two Export Options.
   - Zipped – When checked, Apex will compress your exported data in a .zip file format.
   - Calibrate Data – When checked, Apex will export the calibrated data. If this box is unchecked Apex will export the raw data.

7. In the “Export File Types” box select “CSV or Shape” file format.
   - CSV File – Text file format that contains comma-delimited values.
   - Shape File – ESRI standard format file with point, polygon and lines to display a Geographic Information System map.
8. In the “Save To Folder” box click on the “Ellipsis” button to select the location for the data to be saved.

9. Select the location for your data to be saved and select “OK.”

10. Select “Export” to export your data.

Export Operation Data

Client Maps

A Client Map is a view of all active field boundaries for the selected client. Each field boundary will be color coded according to the farm the field is associated with.

For more information regarding boundaries, click here.

To view a different Client Map, select a different client from the Map Tree.

Commands from the Client map

Functional Area from the Client Map

The following Map Tools are available while viewing a Client Map.

FULL EXTENT
SELECT
ZOOM IN
ZOOM OUT
PAN
SPLIT MAPS
PRINT MAP
RULER

Functional Area in Client Map

While viewing a Client Map, Legend is the only functionality available in the Functional Area.

Farm Maps

A Farm Map is a view of all active field boundaries for the selected farm. Field boundaries will be displayed along with the field names and area. If the active boundary was created with field data, the field will be color coded according to the crop that was specified in the field data.

For more information regarding boundaries refer to Boundaries.
To view a different Farm Map, select a different farm from the Map Tree.

**Commands from the Farm Map**

Functional Area from the Farm Map

The following Map Tools are available while viewing a **Farm Map**.

- FULL EXTENT
- SELECT
- ZOOM IN
- ZOOM OUT
- PAN
- PRINT MAP
- SPLIT MAPS
- RULER

For more information regarding the functionality of Map Tools click here.

**Functional Area in Farm Map**

While viewing a Farm Map, Legend is the only functionality available in the Functional Area.

Legend

**Field Maps**

A field map is a view of the active field boundary. These boundaries can be created from the data collected in the field or created using aerial images within Apex.

To view a different field, select a different field from the Map Tree.

**Commands from a Field Map**

The following Map Tools are available while viewing a **Field Map**.

- FULL EXTENT
- SELECT
- ZOOM IN
- ZOOM OUT
- PAN
- PRINT MAP
- SPLIT MAPS
- RULER
For more information regarding the functionality of Map Tools click here.

**Functional Area in Field Map**

While viewing a Field Map, Legend is the only functionality available in the Functional Area.

Map Layers
- Application
- Background Maps
- Boundary
- Composite
- Delta T
- Flag
- Guidance
- Harvest
- Management Zone
- Other
- Prescription
- Seeding
- Temperature
- Tillage
- Wind Speed

**Map Layers**

**Summary Map Layers**

HARVEST MAPS
APPLICATION MAPS
TANK MIX MAPS
SEEDING MAPS
TILLAGE MAPS
MANAGEMENT ZONE MAPS
PRESCRIPTION MAPS
AERIAL IMAGE MAPS
BOUNDARY MAPS
FLAGS
GUIDANCE
COMPOSITE MAPS
DATA MERGING

**Background Maps**
Background Maps include aerial images and other map layers that have been created from operation and management zone map layers.

An aerial Image Map is an overhead view of the earth’s surface that can be downloaded through GSDNet from icubed (USA feature only) for free. To download Aerial Images you must have a valid GSDNet subscription and an Internet connection.

For more information on aerial images, click here.

### Application Maps

**Application Target Rate Layer**
1. An Application Target Rate Layer shows all the application rates selected by the operator.

**Application Control Rate Layer**
1. An Application Control Rate Layer shows all attempted application rates from the rate controller.

**Application Measured Rate Layer**
1. An Application Measured Rate Layer is the actual reading of all applied application rates as indicated by the sensors on the rate controller.

**Application Depth Layer**
1. An Application Depth Layer shows all application depths selected by the operator.

**Elevation Layer**
1. An Elevation Layer shows all elevation points that were recorded during the application operation.

### Boundaries

**Field Boundaries:** Boundaries that are created in the field with the GreenStar 2 System or Original GreenStar System. They can also be boundaries that are manually created from field data or aerial images within Apex using the Boundary Editor.

**Exterior Boundaries:** Show up as solid black lines (Color can be changed using Edit Boundary panel).

An Exterior Boundary defines the extent of a field and is represented by a polygon shape that extends to the perimeter of the field. Exterior boundaries are used to clip other map layers and play a role in the function of Swath Control Pro and iTEC Pro. Exterior Boundaries can be created in the field with a GreenStar 2 system, an Original GreenStar system, or in Apex. Boundaries created in Apex can be manually drawn or auto-generated based on field data.

**Headland Boundaries:** Show up as dashed red lines.

Headland boundaries define areas near the edges of a field where the direction of the planted crop is perpendicular to the direction of the field length rows. Headland boundaries are an integral part of Swath Control Pro and iTEC Pro and can only be created in the field using the GreenStar 2 system. Headland boundaries can be imported, displayed, and exported from Apex.

**Interior Passable Boundaries:** Show up as solid yellow lines.

**Interior Impassable Boundaries:** Show up as solid black lines inside of exterior boundary.

Interior boundaries define areas within an exterior boundary that are presumably not cropped. An example of an interior boundary is a grassed waterway that is in the interior portion of a field. Interior boundaries can be classified as passable or impassable and are an integral part of Swath Control Pro and iTEC Pro. Interior Boundaries can only
Maps

be created in the field with the GreenStar 2 system. Internal boundaries can be imported, displayed, and exported from Apex.
NOTE: An exterior boundary must be present to view interior and headland boundaries. If the exterior boundary is deleted, interior and headland boundaries will also be deleted.

NOTE: An exterior boundary is required in order to unload headland, interior passable, and interior impassable boundaries into Apex for a field. Headland, interior passable and interior impassable boundaries are view-only and can only be created in the GreenStar 2 display and then unloaded into Apex.

View A Boundary
Edit Existing Boundary
Boundary Summary
Boundary Create Functional Area
Create a New Boundary
Create Exterior Boundaries Manually
Create Interior Boundaries Manually
Auto Generate Boundaries
Print Boundary
Save Boundaries
Deleting an Area of the Field
Copy and Paste
Editing a Single Vertex
Undo and Redo
Moving a Boundary

Composite Maps

The composite maps function in Apex allows a user to combine multiple map layers for the same field and generate a new aggregate layer with the input information. An example of a composite yield map includes using yield maps from three different years to generate a new composite map layer. This new map shows within-field variability in yield across all three years. These maps distinguish yield zones based on past yield data and may be useful for creating yield management zones. Once created, composite maps can be used to generate management zones which can be used to create a variable rate prescription.
Step 1: Select input layers in the map tree. Visible layers will be used to create a composite. The top two field maps are examples that show two years of yield data.

Step 2: Generate composite map. The last picture is an example that shows a composite yield map.

Create Composite Maps
- Generate Composite Map Using Merge/Replace Composite Option
- Composite Map Legend
- Composite Map Summary
- Composite Map Create Functional Area
- Print Composite Map Summary

**Delta T Maps**

The Delta T layer shows Delta T values that were recorded using John Deere Mobile Weather.

**Flag Maps**

Flags are markers used to track the location of objects or conditions in the field as points, lines or areas. Point flags represent a single location such as a tile inlet. Line flags represent two points such as a tile line. Area flags represent a closed shape consisting of a collection of points such as an area where the crop is drowned or washed out.

Flags can be unloaded from a card into Apex and then edited or created in Apex using a map layer. These flags can be saved to card for use in GreenStar 2 System.

For more information on Flags, click here.

**Guidance Maps**
Apex will display if a guidance line has been shifted and if so how far it is from the original location. The user will see a solid black line indicating the original line and a dashed blue line showing where the shift is, if there is one present. The user will also see the total distance the line was shifted displayed on the map.

**A/B Tracks**

A/B tracks are straight line paths that are used to guide the vehicle through the field. Each line is separated by one track spacing (usually the measurement of the implement/machine width).

**A/B Curves & Curved Tracks**

An A/B Curve is a curve that is recorded to follow a contour, side hill, etc. Each adjacent curve is separated by one track spacing, and each curve has the same shape as the initial curve.

**Circle Track**

A Circle track is a circle that is defined for use in center pivots to guide the vehicle on track, where each track is one track spacing apart.

---

**Harvest Maps**

**Dry Yield Layer**
1. A Dry Yield Layer shows yield data after drying calculations have been applied in Apex.

**Moisture Layer**
1. A Moisture Layer shows the actual crop moisture measured by the sensors.

**Wet Weight Layer**
1. A Wet Weight Layer shows the actual crop weight measured by the sensors before drying calculations have been applied.

**Dry Weight Layer**
1. A Dry Weight Layer shows the crop weight after drying calculations have been applied in Apex.

**Elevation Layer**
1. An Elevation Layer shows all elevation points that were recorded during the harvest operation.

**Lint Yield Layer**
1. A Lint Yield Layer shows yield data after lint percentage calculations have been applied in Apex.

**Seed Cotton Weight Layer**
1. A Seed Cotton Weight Layer shows the actual seed cotton weight measured by the sensors.

**Lint Weight Layer**
1. A Lint Weight Layer shows the cotton weight after lint percentage calculations have been applied in Apex.

**Variety Layer**
1. A Variety Layer shows all seed varieties harvested.

**Elevation Layer**
1. An Elevation Layer shows all elevation points that were recorded during the harvest operation.

---

**Management Zone Maps**

A Management Zone Layer shows a zone classification of a field. Each zone will be given a color description.
For more information on importing Management Zones, please click here.

For information on creating Prescriptions from Management Zones, click Here.

**Prescription Maps**

Prescription Map is a graphic representation of what product to apply or seed to plant in a field and the rate at which each are done. Unlike the other maps in Apex, the Prescription is manually created by the user.

For more information on creating Prescriptions in Apex, please click here.

**Seeding Maps**

**Seeding Target Rate Layer**
1. A Seeding Target Rate Layer shows all seeding rates selected by the operator.

**Seeding Control Rate Layer**
1. A Seeding Control Rate Layer shows all attempted seeding rates from the rate controller.

**Seeding Measured Rate Layer**
1. A Seeding Measured Rate Layer is the actual reading of all applied seeding rates applied as indicated by the sensors on the rate controller.

**Seeding Depth Layer**
1. A Seeding Depth Layer shows all seeding depths selected by the operator.

**Variety Layer**
1. A Variety Layer shows all seed varieties planted.

**Elevation Layer**
1. An Elevation Layer shows all elevation points that were recorded during the seeding operation.

**Tillage Maps**

**Tillage Depth Layer**
1. A Tillage Depth Layer shows all tillage depths selected by the operator.

**Elevation Layer**
1. An Elevation Layer shows all elevation points that were recorded during the tillage operation.

**Temperature Maps**

The Temperature layer shows temperature values that were recorded using John Deere Mobile Weather.

**Wind Speed Maps**
The Wind Speed layer shows wind speed values that were recorded using John Deere Mobile Weather.

**Map Tree and Right Click Options**

The Map Tree gives you the ability to view multiple clients, farms, fields, and map layers. Clicking on the different available maps displays the specific map layer you selected in the Map Viewing Area. The following layers will be viewable in the map tree: “Operational layers, Flags, Guidance tracks, Aerial Image, Boundary and Management Zones.”

**Right Click Options on Map Tree**

These options are available when you right click on a node in the map tree. Not all options are available for all layers.

**Create New Map** - Use this option to open a new map layer in a new Map Viewing Area.

1. From the map tree right mouse click on the map layer to be opened.
2. Select “Create New Map.”
3. Apex will display the map layer in the Map Viewing Area and add to the Map Layers Window.

**Add to Current Map** - Use this option to add a map layer to the current Map Viewing Area.

1. From the map tree right mouse click on the map layer to be added.
2. Select “Add to Current Map.”
3. Apex will display the selected map layer in the current Map Viewing Area and add the map layer to the top of the Map Layers Window.

**Add to Map** - Use this option to add a map layer to a specific Map Viewing Area when multiple Map Viewing Areas are open.

1. From the map tree right mouse click on the map to be opened.
2. Select “Add to Map.”
3. Apex will display the names of all Map Viewing Areas. Names of the Map Viewing Areas correspond to the active map layer name for that window.
4. Select the Map Viewing Area the map layer should be added to.
5. Apex will add the selected map layer in the selected Map Viewing Area and Map Layers Window.

**EDIT OPTIONS**

**Edit Options**

“Move to”, “Copy to”, “Merge with” and “Delete” options are available by selecting a map layer in the Map Tree and selecting “Edit” on the Menu Bar or right mouse clicking on the map layer. Not all options are available for all map layers. The table below describes which options are available for each map layer.
<table>
<thead>
<tr>
<th>Map Layer</th>
<th>Edit Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Move To</td>
</tr>
<tr>
<td>Client</td>
<td>✓</td>
</tr>
<tr>
<td>Farm</td>
<td>✓</td>
</tr>
<tr>
<td>Field</td>
<td>✓</td>
</tr>
<tr>
<td>Year</td>
<td>✓</td>
</tr>
<tr>
<td>Operation</td>
<td>✓</td>
</tr>
<tr>
<td>Crop/Product</td>
<td>✓</td>
</tr>
<tr>
<td>Flag</td>
<td>✓</td>
</tr>
<tr>
<td>Management Zones</td>
<td>✓</td>
</tr>
<tr>
<td>Prescriptions</td>
<td>✓</td>
</tr>
<tr>
<td>Aerial Image</td>
<td>✓</td>
</tr>
<tr>
<td>Boundary</td>
<td>✓</td>
</tr>
<tr>
<td>Composite Maps</td>
<td>✓</td>
</tr>
<tr>
<td>Guidance</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Move To** - Use this option of moving your data from one place to another using right click options from your mouse. For more information on "Move To," click here.

**Copy to** - Use this option to copy map layers from the source location to a new location. A new copy will be created in the new location.

**Merge With** - Use this option to merge map layers into another Client/Farm/Field, and have new data read from the original link to the link it was merged to. For more information on Merge With, click here.

**Delete** - Use this option to delete map layers from the Map Tree.

**NOTE:** Deleting data will not delete it from the archive. You can re-unload operational layers, flags, guidance tracks and boundaries which were imported from GreenStar. You can re-import aerial images, management zones and boundary shapefiles. Data created in Apex such as prescriptions, flags, boundaries, guidance tracks and composite maps or aerial images and soil maps downloaded from GSDNet will be deleted permanently. For more information about backing up and restoring data, click here.

**Collection** - Collection allows the functionality of "Move to", "Copy to", "Merge with" and "Delete to be applied to all map layers under a single map layer.
To generate a profit report click the Profit Icon on the main tool bar.

After Clicking the Profit Icon the **Create Price Template** screen will appear. From this screen you can create a new price template. A price template must be created before any reports can be completed.

If a price template is already completed you can do one of the following.

From the **Record Keeping** Section

- Create Price Template
- Edit Price template
- Apply Price Template

You can also run one of the following reports from the **Reports** section

- **Enterprise Summary**
- **Field Summary**
- **Operator Summary**
- **Operation Summary**
- **Product Summary**
1) Screen Name
Displays the screen name.

2) Record Keeping Section
Displays the record keeping tasks that can be performed.

3) Reports Section
Displays the report types that can be run.

Create Price Template

In order for a report to be ran, a price template must be created. To create a new price template click the profit Icon on the main tool bar or click Create Price Template in the record keeping section of the side bar. When either of those selections are made the Create Price Template page will appear.
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Price Template Name</strong>&lt;br&gt;Give the name of the template.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Crop Season</strong>&lt;br&gt;Give a list of the crop seasons.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Operation</strong>&lt;br&gt;Give a list of operations such as harvest, tillage, and planting.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Include &quot;retired&quot; items in list</strong>&lt;br&gt;Inputs the items that have been selected as &quot;retired&quot;.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Expense from Products and Resources Tab</strong>&lt;br&gt;Where you select the products and resources used for this template.</td>
</tr>
<tr>
<td>6</td>
<td><strong>Income from sales Tab</strong>&lt;br&gt;Where you select the products that gave an income for this template.</td>
</tr>
<tr>
<td>7</td>
<td><strong>Miscellaneous Expense Tab</strong>&lt;br&gt;Where you can select a miscellaneous expense.</td>
</tr>
<tr>
<td>8</td>
<td><strong>Miscellaneous Income Tab</strong>&lt;br&gt;Where you can select a miscellaneous income.</td>
</tr>
<tr>
<td>9</td>
<td><strong>Save</strong>&lt;br&gt;Saves the current template.</td>
</tr>
<tr>
<td>10</td>
<td><strong>Items</strong>&lt;br&gt;Displays each item that can be selected for a certain tab.</td>
</tr>
</tbody>
</table>

1. Enter a name for the Price Template.
2. Select the crop season.

3. Select the type of operation for the template.

4. If desired check the Include "Retired" items in list box.

5. Under the Expense from Products and Resources Tab select all of the products and resources that will be used in this template.
   - When each expense is selected a price and unit must be entered.
     a. Select the expense
     b. In the Price column enter the price for the expense.
     c. In the Unit column select the type of unit. By clicking the arrow a drop down menu will appear.

6. Under the Income from Sales Tab select the income product for this template.
   - When an income item is selected a price and unit must be entered.
     a. Select the income product.
     b. In the Price column enter the price for the income
     c. In the unit column select the type of unit. By clicking the arrow a drop down menu will appear.

7. If desired select a Miscellaneous Expense.

8. If desired select a Miscellaneous Income.

9. When all information is entered click the Save button to save the template.
**Edit Price Template**

To Edit a Price template click **Edit Price Template** under the Record Keeping Section of the **side bar**.

Clicking edit price template will make the Edit Price Template selection screen appear.

![Edit Price Template](image)

---

**Note:** Deleting a price template will also delete the record keeping maps.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1) Template Name</strong></td>
<td>Displays the templates that are available to be edited.</td>
</tr>
<tr>
<td><strong>2) Retired</strong></td>
<td>Indicates whether the template has been retired.</td>
</tr>
<tr>
<td><strong>3) Include &quot;Retired&quot; items in List</strong></td>
<td>Allows user to include &quot;retired&quot; items.</td>
</tr>
<tr>
<td><strong>4) Modify</strong></td>
<td>Click Modify button to modify the selected template.</td>
</tr>
<tr>
<td><strong>5) Delete</strong></td>
<td>Click Delete button to delete the selected template.</td>
</tr>
<tr>
<td><strong>6) Retire</strong></td>
<td>Click Retire button to retire the selected template.</td>
</tr>
</tbody>
</table>

1. Select the template to be edited and click the **modify** button.

Once the Modify button has been clicked the template to be edited will appear.
2. Make the desired changes.

3. Click **update** to save any changes and return to the edit price template selection page. Click **cancel** to cancel all changes and return to the edit template selection page.

---

**Import Price Template**

To Import a Price template click **Edit Price Template** under the Record Keeping Section of the **side bar**.

Clicking edit price template will make the Edit Price Template selection screen appear.

1. Select “**Edit Price Template**”.

2. Select “**Import**” on right side of window.

3. Find file to import and select “**Open**”

---

**Export Price Template**

To Export a Price template click **Edit Price Template** under the Record Keeping Section of the **side bar**.

Clicking edit price template will make the Edit Price Template selection screen appear.

1. Select “**Edit Price Template**”.
2. Place a check box for each template to export.
3. Select “Export” on right side of window.
4. Select location to export to and select "OK".

**Apply Price Template**

To apply a price template click **Apply Price Template** under the record keeping section on the side bar.

Once apply Price Template has been selected the apply price template screen will appear.

<table>
<thead>
<tr>
<th>1) Available Price Templates</th>
<th>Selects the template to apply.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2) Crop Season</td>
<td>Selects the crop season to apply template to.</td>
</tr>
<tr>
<td>3) Operation</td>
<td>Selects the operation to apply the template to.</td>
</tr>
<tr>
<td>4) Fields</td>
<td>Selects the fields to apply the template to.</td>
</tr>
</tbody>
</table>
1. Select the **Price Template** to apply.
2. Select the **Crop Season** to apply template to.
3. Select the **Operation** to apply the template to.
4. Select the **Fields** to apply the template to.
5) Once the information is selected click the **Apply** button to apply the template to the selected options.

Wait for confirmation that the template was applied successfully.

Once the template is applied you can view the Reports.

**Enterprise Summary**

After a price template has been applied you can now generate reports.

The enterprise summary gives a report of the entire Enterprise for the template that was applied.

To Create an enterprise summary

1.) Click **Enterprise Summary** under the **Reports** section of the Profit Side Bar.

2.) Select the Crop season for the Report.

3.) Select Generate.
The Enterprise Summary will generate in the screen.

For the functions available in the Enterprise Summary Screen View the Reports Tool Bar.

Field Summary

After a price template has been applied you can now generate reports.

Field Summary report shows a summary of a selected field for the Applied Price Template.

To generate a field summary

1.) Click Field Summary under the Reports section of the Profit Side Bar.

2.) Select the crop season

3.) Select the field

4.) Click generate

Once the Field Summary has been generated it will appear in the screen.

For the functions available for the Field Summary screen view the Reports Tool Bar

Operation Summary
Apex User Guide

After a price template has been applied you can now generate reports.

**Operation Summary** shows a report for a selected operation from the Applied Price Template.

![Operation Summary screenshot](image)

To Generate an operation summary

1.) Click **Operation Summary** under **Reports** section of the Profit Side Bar.

2.) Select the crop season

3.) Select the field

4.) Select the operation

5.) Click Generate to generate an Operation Summary.

Once the Operation Summary has been generated it will appear in the screen.

For the functions available for the **Operation Summary** screen view the Reports Tool Bar.

**Operator Summary**

After a price template has been applied you can now generate reports.

**Operator Summary** shows a report for a selected operator in the Applied Price Template.
To generate an operator summary

1.) Click **Operator Summary** under **Reports** section of the Profit Side Bar

2.) Select the crop season

3.) Select the operator

4.) Select the field

5.) Click generate

Once the operator summary has been generated it will appear in the screen.

For the functions available for the **Operator Summary** screen view the Reports Tool Bar.

---

**Product Summary**

After a price template has been applied you can now generate reports.

Product Summary shows what products were used as an input during a selected crop season for the Applied Price Template.
To generate a product summary

1.) Click **Product Summary** under **Reports** section on the Profit Side Bar.

2.) Select a crop season

3.) Click Generate

Once the product summary is generated it will appear on the screen.

For the functions available for the **Product Summary** screen view the Reports Tool Bar.

**Reports Tool Bar**

Each Profit report page has this tool bar.

Below are a list of functions for each icon.

<p>| 1) Table of Contents | Creates a table of contents for the Report |
| 2) Print | Prints the current report |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3) Export</td>
<td>Saves the current report to another location</td>
</tr>
<tr>
<td>4) Copy</td>
<td>Copies the current report to be pasted to another location.</td>
</tr>
<tr>
<td>5) Find</td>
<td>Provides the ability to search the current summary for keywords.</td>
</tr>
<tr>
<td>6) Single page View</td>
<td>Shows a single page in the screen.</td>
</tr>
<tr>
<td>7) Multiple Page View</td>
<td>Shows multiple pages in the screen.</td>
</tr>
<tr>
<td>8) Continuous Scroll</td>
<td>Provides the ability to scroll all pages of the summary.</td>
</tr>
<tr>
<td>9) Page Size</td>
<td>Allows user to change the size of the page.</td>
</tr>
<tr>
<td>10) Page Up</td>
<td>Clicking will move summary up one page.</td>
</tr>
<tr>
<td>11) Page Down</td>
<td>Clicking will move summary down one page.</td>
</tr>
<tr>
<td>12) Current Page Number</td>
<td>Shows the current page number of the summary.</td>
</tr>
</tbody>
</table>
To ensure that a person can correctly read a map, a Map Legend gives you explanation of colors or symbols used on a map. Similar to a dictionary, the legend provides you the meaning of what colors or symbols on the map represent. For example, you may use the color green to illustrate high yielding corn on your map, so this color is set to display all yield values from 190-350 bu/ac. Matching a range of values to a color will help you make comparisons of multiple field maps.

Legend Templates

Legend templates allow you to pre-save a legend for a selected map type (e.g. dry yield, seed rate). The saved legend template can then be applied to particular client/farm/field of similar map types or be applied in batch to all client/farm/fields containing the information setup in the template. For example, you can create a “Soybean Yield” legend including the same 3 classes (yellow = 10-30 bu/ac, orange = 31-50 bu/ac, green = 51-150) and apply this legend to multiple client/farm/field with soybean harvest information.

NOTE: If a user creates a legend template for dry yield, this template can be applied to all dry yield layers if the product selected matches that of the template. Legend templates will not apply to a variety map.

Creating a Legend Template

1. Click on “Setup” icon.
2. Click on “Legend” under Miscellaneous on the left hand column of the screen.
3. Click “New” to create a legend template.
4. Create a template name; this will be the name that identifies the legend. Template names must be unique.
   NOTE: It is recommended that you give a descriptive name that includes the map type, product and purpose.
   🌟 A red star represents required information.
5. Select Legend type: there are different map types a legend can be created for. The list includes:
   • Dry Yield
Apex User Guide

- Harvest Moisture
- Wet Weight (Seed Cotton Weight)
- Wet Weight Forage
- Dry Weight (Lint weight)
- Dry Weight Forage
- Lint Yield
- Application rate volume (covers measured, target, and control rates)
- Application rate mass (covers metered, target, and control rates)
- Application depth
- Seeding Depth
- Seed rate mass
- Seed rate seeds
- Tillage Depth
- Elevation
- Normalized Data – Percentage
- Normalized Data – Standard Deviation

6. Select the Product from the dropdown box, you will be able to select from the following options:
   1. • Not Product Specific: By choosing the first Product option, “Not product • specific” a legend does not need to be tied to a specific product. For example; if the legend type is “Seed rate mass” and the product chosen is "Not product specific". This legend could then be applied to any seeding map that is expressed in mass (lb/acre, kg/ac etc).
   2. • Crop types: The product list displays only crops that are not retired. For example; if you are creating a template for "Dry Yield" and "Asparagus" and asparagus is in the retired list of crops, you will need to go to crop editing and uncheck the retired check box for asparagus.
   3. • Application: For product application related legend types, the product list displays fertilizers, chemicals and “Tank Mix.” If “Tank Mix” is selected this template will be valid for all products assigned to a tank mix.

7. Select the Unit of Measure: the unit of measure available will reflect the legend type you have selected.

8. In the “Populate Initial Working Set” group box select a color scheme to assign to the new legend.

9. Select “Populate based on the following information.”

10. Enter a minimum and maximum value for the legend.

11. Select number of classes desired.

12. Click “Populate.” This will generate the new Legend template in the box to the right. You can edit the minimum and maximum values in each class to create your desired template.

13. After you have edited legend values and have a template that you want to use consistently in Apex, you have the option to select the template as your default template. Check the "Use as Default" box to make Apex use this legend for all maps (of the specific legend type) that do not currently have a legend assigned.

14. To save the template, select “Add to List” or “Done.” To discard any changes, select the “Cancel” button. • Selecting “Add to List” will allow you to create another legend template. Selecting “Done” will add the template you are working on to the list, close the “Add new legend template” group box and then take you back to the “Existing Legends” group box.

**Generate a New Legend Template**

1. Select "populate based on the following information."

2. Input minimum and maximum levels.

3. Select number of classes desired.

4. Click populate.
Modify an Existing Template

1. Click on “Setup” icon.
2. Click on “Legend” under Miscellaneous on the left hand column of the screen.
3. In the “Existing legend” group box select the legend that you want to modify.
4. Select “Modify.” This will prompt the “Edit legend template” group box.
5. Modify template to desired legend format and select “Update” to keep changes or “Cancel” to disregard any changes.

Use as Default

If "use as default" is checked, then Apex will use this legend template for all maps (of the specific legend type) that do not have a current legend assigned to them.

Create a Legend by a Map

1. Select “Maps” icon.
2. In the map tree select the Client\Farm\Field and layer of which you wish to create a legend.
3. If you wish to use a legend already created for a map select the drop down under "Use Template" to select the desired template (see Legend Templates).
4. To generate a new legend under “Generate New” you can edit the following information by selecting “Method of Classification, Range, and Color Scheme.”

   a) Natural breaks: The natural breaks legend weighs the number of points within a particular range and assigns colors accordingly. This results in a legend that is more finely tuned in areas with more common values vs. ranges that are distributed evenly.

   b) Standard deviation: This works by adding or subtracting the standard deviation from the mean value (average). You have four choices to choose from .25, .50, .75, or 1.00. Standard deviation works best on fields with large data spikes.

   c) Target values: This method is best for application and seeding rate layers. The legend is calculated using your application or seeding target rates. Apex will create eight target values based upon the field data collected. For harvest, and moisture layers this uses a pre-saved minimum and maximum yield or moisture value that is then divided in to equal intervals.

Edit a Legend Template

Edit minimum and maximum levels

1. Click on number you would like to change.
2. Input new number desired.

Edit level color
1. Click on the color of the specific level you plan to change.

2. Select the color you wish to use.

3. Select OK to activate color.

**Rounding precision**

1. Click the up or down arrow for the desired number of decimal points.

---

**Edit a Map Legend**

**Edit minimum and maximum levels**

1. In the map tree select the client\farm\field and layer of which you wish to edit.

2. In the legend grid click the minimum and maximum numbers you wish to change.

3. Input the desired number.

**Edit level color**

1. Click on the color box for the specific level you want to change. This will prompt a color edit box.

2. Select the new color you wish to use.

3. Select “OK” to activate color.

**Rounding precision**

1. Click the up or down arrow for the desired number of decimal points to be displayed.

---

**Saving a Map Legend as a Template**

1. In the map tree select the client\farm\field and layer of which you wish to view.

2. Go to the functional area and select “Save as Template.” This will take you to the “Add New Legend Template” window.

3. Fill in the template name.

4. Select the “Legend Type, Product, and Unit of Measure” from the dropdown boxes.

5. Fill in the other required information.

6. Select “Done.”

---

**Apply a Map Legend to Another Map**

1. In the map tree select the client\farm\field and layer of which you wish to view.
2. Go to the functional area and select “Apply to other Maps.” This will take you to the “Apply Legend Template” window.

3. From the map tree expand enterprise, client, farm and field to select the desired maps you wish to apply the legend to.

4. Click “Apply.”

## Normalize Maps

Normalized data quickly shows the average distribution of a field’s yield data. A normal distribution of data means that most yield points will be close to the “average” bushels per acre (found by selecting the Field Information button), while a few yield sites will tend to fall above or below the average.

Because you are looking for not only the average, but also for the values that fall above and below the average, it may easier to use legends that contain an odd number of increment colors. For example, if your legend uses five colors you know that the average will be the middle color, and that the two colors above the middle will represent higher than average yield, and the two colors below it will represent below average yield.

In addition to defining the number of color breaks, you also need to choose the measuring value: percentages or standard deviation.

If you choose to use percentages, the average yield of a field is set to a value of a 100. Any yield data that is better than average is given a percentage value greater than 100, and any yield data that is below average is given a percentage value less than 100.

If you choose to use standard deviation, the average yield of a field is set as the mean. Apex then disperses the data above and below the mean into deviations.

Use the radio button on the legend functional area for an operational map layer to normalize the data. Normalization method can be changed using the Maps Preference.
Boundaries

**Field Boundaries:** Boundaries that are created in the field with the GreenStar 2 System or Original GreenStar System. They can also be boundaries that are manually created from field data or aerial images within Apex using the Boundary Editor.

**Exterior Boundaries:** Show up as solid black lines (Color can be changed using Edit Boundary panel).

An Exterior Boundary defines the extent of a field and is represented by a polygon shape that extends to the perimeter of the field. Exterior boundaries are used to clip other map layers and play a role in the function of Swath Control Pro and iTEC Pro. Exterior Boundaries can be created in the field with a GreenStar 2 system, an Original GreenStar system, or in Apex. Boundaries created in Apex can be manually drawn or auto-generated based on field data.

**Headland Boundaries:** Show up as dashed red lines.

Headland boundaries define areas near the edges of a field where the direction of the planted crop is perpendicular to the direction of the field length rows. Headland boundaries are an integral part of Swath Control Pro and iTEC Pro and can only be created in the field using the GreenStar 2 system. Headland boundaries can be imported, displayed, and exported from Apex.

**Interior Passable Boundaries:** Show up as solid yellow lines.

**Interior Impassable Boundaries:** Show up as solid black lines inside of exterior boundary.

Interior boundaries define areas within an exterior boundary that are presumably not cropped. An example of an interior boundary is a grassed waterway that is in the interior portion of a field. Interior boundaries can be classified as passable or impassable and are an integral part of Swath Control Pro and iTEC Pro. Interior Boundaries can only be created in the field with the GreenStar 2 system. Internal boundaries can be imported, displayed, and exported from Apex.

**NOTE:** An exterior boundary must be present to view interior and headland boundaries. If the external boundary is deleted interior and headland boundaries will also be deleted.

**NOTE:** An exterior boundary is required in order to unload headland, interior passable, and interior impassable boundaries into Apex for a field. Headland, interior passable and interior impassable boundaries are view-only and can only be created in the GreenStar 2 display and then unloaded into Apex.

**View A Boundary**
**Edit Existing Boundary**
**Boundary Summary**
**Boundary Create Functional Area**
**Create a New Boundary**
**Create Exterior Boundaries Manually**
**Create Interior Boundaries Manually**
**Auto Generate Boundaries**
**Print Boundary**
**Save Boundaries**
**Deleting an Area of the Field**
**Copy and Paste**
**Editing a Single Vertex**
**Undo and Redo**
**Moving a Boundary**

---

Create A New Boundary
Create a New Boundary:

1. Open an operational layer, aerial image, or management zone to use as a reference to create a boundary.

2. Select the "Create" icon in the functional area.

3. Select "Boundary."

Apex will auto-generate a boundary that encompasses the layer opened in step 1. The boundary consists of a set of points (vertices) connected by a line. Each point (vertex) is numbered and in a clock-wise pattern. Users can modify the shape of the boundary by clicking on a point and dragging it to a new location. Points can be deleted by double-clicking on a point and new points can be added by clicking on the boundary. Apex also creates a boundary name and defines the boundary color. Both the name and color can be changed by the user.

NOTE: The zoom in/out, zoom to full extent, pan and arrow buttons can be used when creating/editing boundaries. Users may want to use the zoom tools to more easily see the points of the boundary.

4. When satisfied with the boundary select “Done” to save. If not satisfied with the boundary select “Cancel” and start the process over.

View Boundary

View A Boundary:

1. Expand the map tree to the field level.

2. Expand the boundary heading and you will see the boundary layers.

3. Select the boundary layer you wish to view and it will appear to the right.

Create A New Boundary

Create a New Boundary:

1. Open an operational layer, aerial image, or management zone to use as a reference to create a boundary.

2. Select the "Create" icon in the functional area.

3. Select "Boundary."

Apex will auto-generate a boundary that encompasses the layer opened in step 1. The boundary consists of a set of points (vertices) connected by a line. Each point (vertex) is numbered and in a clock-wise pattern. Users can modify the shape of the boundary by clicking on a point and dragging it to a new location. Points can be deleted by double-clicking on a point and new points can be added by clicking on the boundary. Apex also creates a boundary name and defines the boundary color. Both the name and color can be changed by the user.

NOTE: The zoom in/out, zoom to full extent, pan and arrow buttons can be used when creating/editing boundaries. Users may want to use the zoom tools to more easily see the points of the boundary.

4. When satisfied with the boundary select “Done” to save. If not satisfied with the boundary select “Cancel” and start the process over.
Create Exterior Boundaries Manually

1. Open any map layer in the Map Tree, and click on the Create Tab.
2. Click the Boundary link.
3. Select the “Draw Manually” button on the toolbar and select a drawing tool from the drop down menu.
4. Click on the map to start drawing.

NOTE: A boundary must have a minimum of 3 points.
5. After drawing the boundary, click on the cursor tool to complete the boundary.

NOTE: When using the polygon tool to draw a boundary, double clicking will complete the boundary drawing.
6. The boundary will be added in the grid, select the boundary type from the drop down. In this case, the boundary is an exterior boundary only.
7. Repeat steps 1-6 if there is more than one exterior boundary in the field.

NOTE: Multiple exterior boundaries CANNOT overlap.
NOTE: Multiple exterior boundaries will be LAND BRIDGED in the GS2 display.
    • For more information on Save to Card, click here.
8. The exterior boundary must have an overall boundary name.
9. Select “Done.” The boundary will be saved in the Map Tree.

Create Interior Boundaries Manually

1. Open any map layer in the Map Tree, and click on the Create Tab.
2. Click the Boundary link.
3. Select the draw manually tab on the toolbar and select a drawing tool from the drop down menu.
4. Click on the map to start drawing.

NOTE: A boundary must have a minimum of 3 points.
5. After drawing the boundary, click on the cursor tool to complete the boundary.
6. The boundary will be added in the grid, select the boundary type from the drop down. In this case, the boundary is an interior passable or interior impassable.
7. Give the interior boundary an unique name.
8. Repeat steps 1-7 if there is more than one interior boundary in the field.
9. Select “Done”. The boundary will be saved in the Map Tree.

Edit Existing Boundaries

Edit Existing Boundaries:
1. Expand the map tree to the boundary level and select a boundary layer to edit.

2. Select the "Edit" icon in the functional area located near the bottom of the screen.

3. To change the name of the boundary, click in the "Boundary Name" box and type the new boundary name you desire.

4. To make this your active boundary, place a check in the "Active" box. An active boundary will be used to clip imported management zones, soil map layers downloaded using GSDNet, and Prescription maps. Active boundaries are also saved to the card.

5. To change the boundary color, select the “Boundary Color” dropdown tab and select a different color.

6. Select "Reduce Points" if you would like reduce the number of points (vertices) in the exterior boundary.

   **Note:** Apex will reduce the points once (pressing the button multiple times will not continue to reduce additional points).

7. Users can modify the shape of the boundary by clicking on a point and dragging it to a new location. Points can be deleted by double-clicking on a point and new points can be added by clicking on the boundary.

8. When satisfied with the boundary, select “Done” to save. If not satisfied, select “Cancel” and start the process over.

There are times when clicking on the map will not add or delete a point. Apex will not add a point if it is too close to an existing point at the current resolution. To resolve, proceed with the following:

1. Select the "Zoom" icon to access the zoom feature, click on the map to increase the resolution. To zoom out select the “Zoom Out” icon and click on the map to decrease the resolution.

2. When you are finished zooming, click the “Select” icon to resume the edit mode.

   Apex will not add or delete a point if the resulting boundary intersects itself. To avoid self-intersecting boundaries it may be helpful to add intermediate points and move so the desired points are added or deleted.

---

**Boundary Summary**

**Boundary Summary**

1. Expand the map tree to the boundary level and select the boundary layer you want to view.

2. Click the “Summary” icon in the functional area. You must assure the boundary is the active layer to view the summary (the active boundary must be highlighted in the map layers window).

3. Summary will display client, farm, field, boundary area, interior boundary area, and field boundary area (exterior boundary minus interior boundary).

   **NOTE:** Summary will be displayed depending upon what boundaries are available in the map layer.

---

**Boundary Create Functional Area**

**Boundary Create Functional Area**

You can create “Guidance,” “Prescriptions,” “Flags,” and download “Aerial Images” and “Soil Maps” when in the boundary create option.
Print Boundary

1. Expand the map tree area to the boundary level and select the boundary layer you want to print.

2. Click the drop down arrow on the “Printer” icon. You will have two options:
   - “Print Map” option will open a printer window and prompt you to select a printer. Once a printer is selected, click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   - Selecting “View Map” will open the boundary summary report. In this report page you will be able to print and export the boundary summary and also enable exporting as a .pdf file that can be saved electronically.

Save Boundary to Data Card

1. Select the “Save” icon to save boundary data to the card.

2. Expand the map tree selection to the boundary level. Select the boundaries you want to save to card plus other information.

   NOTE: If a boundary contains multiple exterior boundaries, the boundaries will be LAND BRIDGED when saved to the card. This is due to limitations in the GS2 Display as it cannot display multiple exterior boundaries.

   Product will still be applied over this narrow strip of land if Swath Control Pro is left on and the overlap is set to 100% in the Swath Control Pro settings page. To prevent unexpected coverage, always turn Swath Control Pro or the master switch OFF while transporting between fields.

See Save to Card section for further instructions.
**Guidance**

**A/B Guidance Tracks**

Apex provides you with the ability to create, manage, and view guidance straight A/B tracks for GreenStar 2 system guidance applications. A/B tracks are straight line paths that are used to guide the vehicle through the field. Each track is separated by one track spacing (usually the measurement of the implement/machine width).

You can view A/B tracks from unloaded field data if guidance A/B tracks were present when the field data was unloaded into Apex.

**View Guidance A/B tracks**

You can create A/B tracks in Apex to be used in GreenStar 2 system guidance applications. Two methods are available to create A/B tracks.

**A + B method:** Select two points on the map and Apex will connect the two points, to create the A/B lines.

**A + Heading method:** Select one point on the map and enter a heading to create the A/B Lines.

**Create A/B tracks from A + B method**

**Create A/B tracks from A + Heading method**

You can manage A/B tracks by editing the name or by sending the A/B track to other data cards to be used in the GreenStar 2 System.

**Edit A/B tracks**

**Summary A/B Tracks**

**Save Guidance Tracks to Card**

**Delete A/B tracks**

**Print A/B Tracks**

**Curve Track Tracks**

**A/B Curves**

An A/B Curve is a curve that is recorded to follow a contour, side hill, etc. Each adjacent curve is separated by one track spacing, and each curve has the same shape as the initial curve.

**View A/B curves that you have unloaded into Apex.**

1. Expand your map tree to the guidance level and select the A/B curve you want to view.
2. The A/B curve will open in the map window and the summary will be displayed.

**Edit A/B Curves**

**Summary A/B Curves**

**Print A/B Curves**

**Curved Tracks**

**View curved tracks that have been unloaded into Apex.**
1. Expand your map tree to Guidance level and select the Curved track you want to view.
2. The curved track will open in the map window and the summary will be displayed.

Edit Curved Track Lines
Summary Curved Track Lines
Print Curved Track Lines

**Circle Track Lines**

A Circle track is a circle that is defined for use in center pivots to guide the vehicle on track, where each track is one track spacing apart.

**View Circle Tracks that have been unloaded into Apex.**

1. Expand your map tree to the Guidance level and select the Circle Tracks you want to view.
2. The Circle Track will open in the map window and summary will be displayed.

Edit Circle Track Lines
Summary Circle Tracks
Print Circle Tracks

**Save Guidance Tracks to Card**

1. Select “File > Save to Card” or you can select the “Save” icon to save Guidance Track data to the card.
2. Expand the map tree to the Guidance level. You will have two options to choose from.
   • Field Specific
   • Global
3. Select the Guidance Tracks you want to save to card plus all the required information.

See Save to Card section for further instructions.
Apex allows you to get a free map of soils characteristics for your fields as defined by the United States Department of Agriculture (USDA) Natural Resources Conservation Service (NRCS) soil survey. The Soil Map shows the distribution of soil types and/or soil properties (i.e. soil map unit name, slope, drainage class, etc.) as defined by the USDA Soil Survey.

Download Soil Map
Soil Map Legend
Create a Prescription using a Soil Map
Soil Map Summary
Soil Map Create Functional Area
Print Soil Map Summary

Download Soil Map

To download soil maps you must have a valid GSDNet subscription and an Internet connection. GSDNet is ONLY available in the USA.

1. Expand the map tree to the “Boundary” level and select a boundary layer to view.

2. Select the “Create” icon in the functional area.

3. Select “Soil Map.”

4. Select the “Download” button.

5. This will prompt the GSDNet authorization screen. Select “Yes” to continue or select “No” to cancel.

6. Selecting “Yes” will require you to enter your GSDNet username and password. Note: If you have already connected to GSDNet in the same session you will not need to enter your GSDNet connection information again.

7. After entering your username and password select the “Login” button. This will allow you access to GSDNet and a progress bar will be displayed.

8. Once the soil map has been downloaded it will be saved in the map tree for the respective Client, Farm, Field and Year. All soil maps will be located under “Management Zones” in the map tree.

9. Select “Done” when you are finished.

NOTE: If you download a soil map for a field that already has a soil map, Apex will overwrite the previously downloaded soil layer.
Soil Map Legend

The Soil Map Legend will display the distribution of USDA Soil Survey characteristics within a field. Individual soil map layers represent different soil properties (i.e. soil map unit name, slope, drainage class, etc.).

To view the soil map legend:

1. Expand your map tree to the “Management Zones” level and select the map layer of the soil characteristic that you want to view.

2. Select the “Legend” icon in the functional area to view the colors associated with each soil property within the selected field.

Soil Map Summary

The Soil Map Summary will display the client, farm and field.

To display the soil map summary:

1. Expand your map tree to the “Management Zones” level and select the soil map that you want to view.

2. Select the “Summary” icon in the functional area.
Soil Map Create Functional Area

You can create “Boundary, Guidance, Prescription and Flags.”

1. Expand your map tree to the “Management Zones” level and select the soil map that you want to view.
2. Select the “Create” icon in the functional area.

Print Soil Map Summary

1. Expand your map tree to the “Management Zones” level and select the soil map that you want to print.
2. Click the drop down arrow on the “Printer” icon. You will have two options:
   • Selecting the “Print Map” will prompt you to select a printer. Once you select a printer click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   • Selecting the “View Map” option will open the Soil Map summary report and also enable exporting as a .pdf file that can be saved electronically.
Background Maps

Background Maps include aerial images and other map layers that have been created from operation and management zone map layers.

An aerial Image Map is an overhead view of the earth’s surface that can be downloaded through GSDNet from icubed (USA feature only) for free. To download Aerial Images you must have a valid GSDNet subscription and an Internet connection.

For more information on aerial images,click here.

Background Map Summary

Background Maps are rate layers, variety maps, management zones, and aerial images that can be saved to the GS2 2600 and viewed as background maps. These maps can be layered underneath the coverage map during any operation.

Create a Background Map for Rate Layers
Create a Background Map for Variety and Management Zone Layers
Edit a Background Map for Rate Layers
Edit a Background Map for Variety and Management Zone Layers
Background Map Legend

Background Map Summary

1. Expand the Map Tree to the Background Map level and select the Background Map you want to view.

2. Select the “Summary” tab from the Functional Area. The following details can be viewed in the Summary panel:
   • Client
   • Farm
   • Field

Print a Background Map Summary

1. Expand the map tree to the “Background Map” level and select the background map you want to print the summary of.

2. Click the drop down arrow on the “Printer” icon. You will have two options:
   • Selecting “Print Map” will prompt you to select a printer. Once you select a printer click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   • Selecting “View Map” will open the Background Map summary report. In this report page you will be able to print and export the Background Map summary.

Save a Background Map to the Card

1. Select the “Save” icon to save the Background Map data to the card.

2. Expand the map tree to the “Background Map” level and select the background map you want to save to card plus all the required information.
   • For more information on Save to Card, click here.

Background Map Legend
Once you have created a Background Map, you can view the zones that have been created in the Legend panel.

1. Expand the Map Tree to the Background Map level and select the Background Map you want to view.

2. Select the "Legend" tab from the Functional Area. The zone Legend will be displayed.
Aerial Imagery

Aerial Images

Apex has the ability to automatically import aerial images from icubed through GSDNet (USA feature only). To download Aerial Images you must have a valid GSDNet subscription and an Internet connection.

Aerial images can be downloaded through two methods:

Download Aerial Images Without Field Data or Field Boundaries

Download Aerial Images With Field Data and Field Boundaries

Once you have downloaded an image, the image will be saved in the map tree under "Background Map."

To display an aerial image that has been previously downloaded, expand the map tree to the "Background Map" level and select the desired aerial image that you want to view.

If the aerial image does not cover the entire field boundary or collected field information, you can download the aerial image again using one of the two options provided below.

Aerial Image Functional Area
Edit An Aerial Image
Aerial Image Summary
Aerial Image Create Functional Area
Print Aerial Image Summary
Save Aerial Images to Card

Download Aerial Images without Field Data or Field Boundaries

If you do not have field data or field boundaries, you can download aerial photos by entering in a specific location to access GSDNet.

1. Expand your map tree to field level and select the field you wish to download and aerial image for.

2. Enter the “City, State, and the Distance” (east/west, north/south) the field is from the city you entered. Select “Get Image” and this will prompt the GSDNet authorization screen. Select “Yes” to continue or select “No” to cancel.

3. Selecting “Yes” will require you to enter your username and password to access the GSDNet connection.

4. After entering your username and password select the “Login” button. This will allow you access to GSDNet and a progress bar will be displayed.

5. GSDNet will then display an aerial photo. Create a polygon around the approximate location of the field by clicking on the map and selecting at least three points. This will provide the ability to download a higher resolution image.

6. Click the “Zoom” button to download the higher resolution image.

7. After the higher resolution image is displayed, click “Boundary” in create functional area to create a field boundary.

8. To create the boundary from the aerial image select at least three points to on the aerial image. Once finished select “Done” this will save your boundary in the map tree. The boundary will be displayed in the map viewing area.

9. Select “Create” icon in the functional area, then select “Aerial Image.” This will allow you to download the aerial image for your field boundary.
Download Aerial Images with Field Data or Field Boundaries

Aerial Images can be downloaded via GSDNet as farm and/or field maps. Field boundaries must exist to view farm maps.

1. Expand the map tree to the “Boundary” level. Select the field boundary that you want to download an aerial image for.
   - Assure that the boundary is selected as the active layer in the map layers window.

2. Select the “Create” icon and then select “Aerial Imagery.”

3. Select the “Download” button.

4. This will prompt the GSDNet authorization screen. Select “Yes” to continue or select “No” to cancel.

5. Selecting “Yes” will require you to enter your username and password to access the GSDNet connection.

6. After entering your username and password select the “Login” button. This will allow you access to GSDNet and a progress bar will be displayed.

7. Once the aerial image has been downloaded it will be saved in the map tree for the respective client, farm, and field. Aerial images will be located under “Background Map” in the map tree.

8. Select the “Done” button to finish.

Aerial Imagery Functional Area

The aerial images tab allows you to view manually imported aerial images or aerial images downloaded through GSDNet. This tab allows you to adjust the position of the image, adjust the transparency of the image, and delete the image.

Adjust the position of the aerial image

Adjust the transparency of the aerial image

To delete the aerial image

Aerial Image Create Functional Area

You can create boundary, guidance and flags from an aerial image.

1. Expand the map tree to the “Background Map” level and select the aerial image you want to view a summary of.

2. Select the “Create” icon.

Delete Aerial Image

You can delete your entire client, farm, fields, boundaries, guidance tracks, soil maps, operational layers, composite maps, flags, aerial images and prescriptions. Or you can delete individual guidance tracks, composite maps, aerial images, flags, boundaries and prescriptions. You cannot delete operational layer attributes such as dry yield and individual management zones.

1. Right click on the layer(s) you want to delete.
2. Select “Delete.”

3. Apex will prompt a confirmation message asking you to proceed with the delete. Select “Ok” to delete or “Cancel” to ignore the delete.

NOTE: Deleting data will not delete it from the archive. You can re-unload operational layers, flags, guidance tracks and boundaries which were imported from GreenStar. You can re-import aerial images, management zones and boundary shape files. Data created in Apex such as prescriptions, flags, composite maps, aerial image and management zones downloaded from GSDNet will be deleted permanently.

For more information on Backup and Restore, click here.

Print Aerial Image Summary

1. Expand the map tree to the “Background Map” level and select the aerial image you want to print the summary of.

2. Click the drop down arrow on the “Printer” icon. You will have two options:
   - Selecting “Print Map” will prompt you to select a printer. Once you select a printer click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   - Selecting “View Map” will open the Aerial Image summary report. In this report page you will be able to print and export the Aerial Image summary.

Save Aerial Images to Card

1. Select the “Save” icon to save aerial image data to the card.

2. Expand the map tree to the “Background Map” level and select the aerial image you want to save to card plus all the required information.

See Save to Card section for further instructions.
Prescriptions

Prescriptions Create Functional Area

You can create “Boundaries, Flags and Guidance” from a prescription layer using the prescription “Create” function.

1. Expand the map tree to the field level and select the prescription you want to view.

2. Select the “Create” icon.

Create Prescriptions by Drawing Shapes Manually

The shape of the application plan is dependent on the field. Therefore, you must have a field boundary. As the field boundary is used as an outline for your application plans, polygons that extend past the field boundary are automatically severed at that line.

To create a prescription using draw shapes manually, you will need a boundary for the client, farm and field. Click here for information on creating a boundary, or click here for information about unloading or importing a boundary.

1. Expand the map tree to the boundary level.
   • You can manually create prescriptions from the following map layers: boundary, aerial image, operational layer, composite maps and management zones.

2. Select the “Create” icon in the functional area, and then select “Prescription.”

NOTE: Once you select the prescription link, map features such as map filter, map tree, map layering window, print, contour, high level and selection tools will be disabled. To enable these features click on “Cancel” or “Done/Save.”

3. Next, select the “Draw zones manually” option and select the “Next” button.

4. Fill out the appropriate information in the following boxes:
   • Plan Name
   • Prescription Type
   • Crop Season
   • Product Type
   • Product Name
   • Units
   • In filed default rates
   • Out of field default rates
   • Field boundary

   If you are creating a prescription from a boundary then that boundary will be listed in the field boundary drop down. If you are using any other layer, then Apex will auto-populate the active boundary in the drop down. You can change the boundary by clicking on the drop down. Each boundary you select will be populated on the maps window.

5. Select “Next” to continue. At any time click “Back” to go back to the previous screen. Clicking “Cancel” will ignore any changes.

6. You can draw and manage your shapes by using the drawing tools. To view a description of each tool, roll your mouse pointer over each icon in the tool bar. Select the Center-Pivot, Rectangle, Ellipse or Polygon drawing tools to create shapes in the map area. (See Section in “Draw Zones Manually” about Drawing Tools for more information).

7. Once you have drawn the shape, right click and select “Assign Rates” or select the “Assign Rates” icon from the functional area.

8. You will see an assign rates pop-up window. Enter in the rate and select a color.
• The color gray is always assigned to the Loss of GPS rate. You can assign the loss of GPS rate to any shape and the color gray will be assigned to that shape.
• Two or more shapes cannot have the same rate with different colors. If the same rates are assigned to multiple shapes then same color will also apply to those rates.
• Once you have drawn the shapes and assigned the rates you can arrange your shapes the way you want to. You can change the rates and colors from the grid in create functional area.

9. Select “Save” to save the prescription.

10. Once prescriptions are created and saved, they will appear in the map tree under the specific field and year layer.

Edit Prescriptions Drawn Manually

### Drawing Tools

- Center Pivot Tool
- Rectangle Tool
- Ellipse Tool
- Polygon Tool
- Bisect Tool
- Undo
- Redo
- Shape to top
- Shape up
- Shape to bottom
- Shape down
- Select all
- Clear all
- Delete
- Copy
- Assign Rates
- Point Flags
- Line Flags
- Area Flags

### Create Prescription Using a Contour Map

You can create a prescription from an operational layer using a contour map.

1. Open an operational layer from the map tree.
2. Adjust your legend (optional).
3. Click on the **contour button** on the top toolbar. Your operational map layer will be converted into a contour map.

**NOTE:** The Contour Prescription option will be enabled even if a Contour Map has not been created. Selecting this option will automatically create a Contour Map, using the default settings. To utilize the Advanced Options feature, follow steps 1-3 above.

4. Select the **“Create” icon** and select **“Prescription.”**

**NOTE:** Once you select the prescription link, map features such as map filter, map tree, map layers window, print, contour, high level, legend functional area and selection tools will be disabled. To enable these features click on **“Cancel”** or **“Done/Save.”**

5. You will have three options available:
• Contour map
• Draw zones manually
• Use existing management zone

6. Select “Contour Map” and click “Next.”

7. Fill out the appropriate information in the following boxes:
• Plan Name
• Prescription Type
• Year
• Product Type
• Product Name
• Units
• In filed default rates
• Out of field default rates
• Field boundary

A boundary is not required to create prescription using a contour map but if you still wish to use a boundary you can select a boundary from the boundary drop down. You can change the boundary by clicking on the drop down. Each boundary you select will be populated on the maps window.

8. Select “Next” to continue. At any time click “Back” to go back to the previous screen. Clicking “Cancel” will ignore any changes.

9. The values from your legend will be populated in the grid view allowing you to assign your desired rates and colors to the legend.

NOTE: Two or more legend rows cannot have the same rate that is the same color. If the same rates are assigned to more than one row then same color will also be applied.

NOTE: A gray color will be assigned to areas inside the field boundary that are not covered by a shape (Loss of GPS rate). You will not be allowed to assign the gray color to any other rate.

10. After rates are added, you will have the ability to edit rates/colors for individual shapes on the map. To edit rates/colors of individual shapes, first proceed with the following:
• First, select the shape on the map by clicking on the shape in the map view.
• Next, in the table select the row of the desired rate/color (not the rate or color column).
• If the rate or color you would like to assign doesn’t exist in the prescription table, you have the option to add a new rate or color by selecting the “Add a Legend Row” icon and assign a different rate and color.

NOTE: You can only delete the added rows, you cannot delete legend rows. If you added a row using one of the above options you can delete that row by selecting that row and then selecting the “Delete” icon. This will delete the added row and assign the default rate and color the corresponding contour area.

11. Once you are done assigning rates and colors, select the “Save” button to save the prescription.

12. Once the prescriptions are created and saved, they will appear in the map tree under the specific field and year.

NOTE: If a field boundary is present, areas outside the field boundary will be clipped and assigned the Out of Field rate when the prescription is saved to the card.

Edit Prescriptions Created From a Contour Map

Create Prescription Using Management Zones

You can use a soil map downloaded from GSDNet or an imported management zone map as the bases of creating a prescription.
Creating a prescription from a management zone map can be started using a field boundary map, logged data map, or the management zone map. If you begin creating a prescription map while viewing a management zone map, the map you are viewing will be used as the foundation of your prescription.

NOTE: To enable the option of selecting and adding rates/colors to individual shapes, you must start the process from a boundary layer as described below:

1. Expand the map tree to the a boundary level and make this layer active by checking this layer in the Map Layers window.

2. Select the "Management Zone" level and select the management zone you want to create the prescription with.

3. Select the “Create” icon and select “Prescription.”

NOTE: Once you select the prescription link, map features such as map filter, map tree, map layers window, print, contour, high level and selection tools will be disabled. To enable these features click on “Cancel” or “Done/Save.”

4. You will have three options available:
   - Contour map
   - Draw zones manually
   - Use existing management zone

5. Select “Use existing management zone” and click “Next.”

6. Fill out the appropriate information in the following boxes:
   - Plan Name
   - Prescription Type
   - Year
   - Product Type
   - Product Name
   - Units
   - In filed default rates
   - Out of field default rates
   - Field boundary

A boundary is not required to create prescription using a management zone but if you still wish to use a boundary you can select a boundary from the boundary drop down. You can change the boundary by clicking on the drop down. Each boundary you select will be populated on the maps window.

7. Select “Next” to continue. At any time click “Back” to go back to the previous screen. Clicking “Cancel” will ignore any changes.

If you did not select a management zone as your map layer then you can select a zone using the window on the right. If you are using an existing management zone as your active map layer then Apex will use that as the foundation of your prescription.

8. Choose between “Use existing rates” or “Manually Assign Rates” and select “Next.”

9. A grid view will be displayed based on your management zone legend.

10. You can enter the rates you want to apply to a particular legend break. You can also change the color of the area by clicking on the color box and selecting the color you want.

11. If you want to assign a management zone a rate other than its original proceed with the following:
   - To assign a different rate or color, select the “Add a Legend Row” icon. Assign a rate and color to the new legend row and then select the management zone area on the map for the new rate and color to be applied.
   Or
   - Select the legend row in the grid and then click on the management zone area on the map to assign the grid rate and color to be applied.
12. You can only delete the added rows, you cannot delete legend rows. If you added a row using one of the above options you can delete that row by selecting that row and then selecting the “Delete” icon. This will delete the added row and assign the default rate and color the corresponding contour area.

13. Once you are done assigning rates and colors, select the “Save” button to save the prescription.

14. Once the prescriptions are created and saved, they will appear in the map tree under the specific field and year.

NOTE: The gray color is for loss of GPS rate. You will not be allowed to assign the gray color to any other rate. Two or more contour areas or legend rows cannot have the same rate that is the same color. If the same rates are assigned to more than one row then same color will also be applied.

Edit Prescriptions Created from Management Zone

1. Expand the map tree to the field level and select the prescription you want to edit.

2. Once the prescription is open in the map window, click on the “Edit” icon.

NOTE: Once you select edit, map features such as map filter, map tree, map layers window, print, contour, high level and selection tools will be disabled. To enable these features click on “Cancel” or “Done/Save.”

3. You have the option to change the prescription plan details. Select “Next” when you are finished with the changes.

4. You can edit your prescription using the drawing tools using the drawing tools.
   • For more detailed instructions refer to the beginning of the chapter – Create Prescriptions by drawing shapes manually. (ADD LINK)

5. Select “Save” once you are finished editing your prescription.

Edit Prescriptions Drawn Manually

1. Expand the map tree to the field level and select the prescription you want to edit.

2. Once the prescription is open in the map window, click on the “Edit” icon.

NOTE: Once you select edit, map features such as map filter, map tree, map layers window, print, contour, high level and selection tools will be disabled. To enable these features click on “Cancel” or “Done/Save.”

3. You have the option to change the prescription plan details. Select “Next” when you are finished with the changes.

4. You can edit your prescription using the drawing tools using the drawing tools.
   • For more detailed instructions refer to: Create Prescriptions using a Contour Map Create Prescriptions using Management Zones

5. Select “Save” once you are finished editing your prescription.

Edit Prescriptions Created From Contour or Management Zones

1. Expand the map tree to the field level and select the prescription you want to edit.

2. Once the prescription is open in the map window, click on the “Edit” icon.

NOTE: Once you select edit, map features such as map filter, map tree, map layers window, print, contour, high level and selection tools will be disabled. To enable these features click on “Cancel” or “Done/Save.”

3. You have the option to change the prescription plan details. Select “Next” when you are finished with the changes.

4. You can edit the rates and colors of the contour map or management zones using the grid view.
   • For more detailed instructions refer to:
     Create Prescriptions using a Contour Map
     Create Prescriptions using Management Zones

You will not be allowed to select a management zone or a contour area once you have created the prescription. In the edit mode you will only be allowed to change the rates and colors.

5. Select “Save” once you are finished editing your prescription.

Prescription Legend

Once you have created a prescription you can view the rates you have assigned from the legend panel.
1. Expand the map tree to the field level and select the prescription you want to edit.

2. Select the **“Legend” icon**. You can view the rates you applied.
   • If you created prescription by drawing zones manually you will see the Loss of GPS rate in the legend grid. Even if you assigned all the regions a rate, the legend will still display the loss of GPS rate. If you created a prescription from a management zone or a contour map and assigned all areas a rate then you will not see the default rate in the legend grid.

### Prescription Summary

1. Expand the map tree to the field level and select the prescription you want to view.

2. Select the **“Summary” icon**. The following details can viewed in the summary panel:
   • Prescription name, year, Rx type, product type, product name, units, loss of GPS rate, out of field rate, area and total needed.
   • If you filled out the variety information for seeds before creating the prescription then you will be able to see three additional columns in the summary functional area:
     - Seed amount
     - Total Needed
     - Total Packages Needed
   • For Chemicals Apex will display the following:
     - Total needed

### Prescriptions Create Functional Area

You can create “Boundaries, Flags and Guidance” from a prescription layer using the prescription “Create” function.

1. Expand the map tree to the field level and select the prescription you want to view.

2. Select the **“Create” icon**.

### Print Prescriptions

1. Expand the map tree to the field level and select the prescription you want to view.

2. Click the drop down arrow on the **“Printer” icon**. You will have two options:
   • Selecting **“Print Map”** will prompt you to select a printer. Once you select a printer click **“OK”** to print the map.
   Selecting **“Cancel”** will close the printer prompt
   • Selecting **“View Map”** will open the Prescription summary report. In this report page you will be able to print and export the prescription summary.

### Save Prescriptions to Card

1. Select the **“Save” icon** to save aerial image data to the card.

2. Expand the map tree to the “Field” level and select the prescription you want to save to card plus all the required information.

See Save to Card section for further instructions.
Composite Maps

The composite maps function in Apex allows a user to combine multiple map layers for the same field and generate a new aggregate layer with the input information. An example of a composite yield map includes using yield maps from three different years to generate a new composite map layer. This new map shows within-field variability in yield across all three years. These maps distinguish yield zones based on past yield data and may be useful for creating yield management zones. Once created, composite maps can be used to generate management zones which can be used to create a variable rate prescription.

Step 1: Select input layers in the map tree. Visible layers will be used to create a composite. The top two field maps are examples that show two years of yield data.

Step 2: Generate composite map. The last picture is an example that shows a composite yield map.

Create Composite Maps
Generate Composite Map Using Merge/Replace Composite Option
Composite Map Legend
Composite Map Summary
Composite Map Create Functional Area
Print Composite Map Summary

Create Composite Maps
Rules for creating composite maps

- Map layers should be of the same client, farm and field.
- Map layers should be of the same task and operation.
- Map layers should have the same attributes, e.g., dry yield cannot be composited with moisture.

You will have two options when selecting the “Generate a Composite Map” icon:

- **Average Composite Option**: This option creates a composite map by averaging selected map layers of the same crop type. If you select different crops, then Apex will normalize the map layers first and then average the normalized layers. This is the most commonly used option for yield and most other map layers.

- **Merge/Replace Composite Option**: This option merges data from two map layers. In areas with spatial overlap, data from the second layer will merge/replace data from the first layer. This option is applicable in a situation such as replanted areas (the same task is conducted twice in a growing season).

**Average Composite Option**

This option creates a composite map by averaging selected map layers. The following simplified illustration demonstrates a composite yield map created by averaging two years of yield data:

![Composite Yield Maps Illustration](image)

Composite yield maps are generated differently depending on the crop types of the selected input layers:

- **Same Crop Type**: If the same crop type is used for input on all layers (i.e., 3 years of corn data), then the method will average layers for all years. The resulting composite map will illustrate average totals in the summary tab. You also have the option to select the “Normalize” button in the layer legend to generate a normalized map for each year.

- **Different Crop Types**: If the crop type varies (i.e., one year of soybean data and two years of corn), then the method will first normalize layers by year and then average the normalized data across years. The resulting composite map will illustrate normalized values in the summary tab.

**NOTE**: Normalization in this example is important in order to equally weight data map layers across years so one year doesn’t influence the composite maps more than another year. Apex offers three different methods for normalizing composite maps. These methods are “Standard Normal (default),” “Mean Adjusted,” and “Relative Adjusted.”

- To change the default method go to “File > Preferences > Maps > Normalization Procedure.”

**Merge/Replace Composite Option**

This option creates a map by replacing overlapping data from the least recent layer with the most recent layer. An example of this situation is illustrated below when a portion of a field is replanted because of a poor stand. The Merge/Replace option uses the seeding layer from April 25th as the base layer and replaces seeding data from May 10th in the areas that overlap.
Create Composite Map Using Average Composition Option

1. Select the “Maps” icon.
2. Expand the map tree to open a map layer.
3. Open a second map layer in the same tab. No limit exists on how many map layers can be used to create a composite map.

NOTE: If you select map layers for a task that has occurred twice in the same growing season (i.e., replanted field may have two planting layers you would like to composite) see “Merge/Replace Composite Option” section below.
4. Click on the “Composite” icon located below the Map Layers Window in the lower left corner.
5. A window will appear with two options, select “Average.”
6. Select “OK” to proceed; selecting “Cancel” will cancel out of the composite map creation screen.
7. You have the option to save or not save the composite map. If you wish to save, enter a unique name and select “Save.” Select “Don't Save” if you wish to not save the composite map and proceed to create the composite map. If you save the composite map you will be able to use this map in the future to create prescriptions.

NOTE: If you do not save the composite map then the new composite map will open in a new tab and once you close the tab you will be prompted again to save. If not saved and the window is closed you will have to generate the composite map again.
8. The composite map will be generated and saved in the Map Tree under the field in “Composite Maps” as an operational layer.

• You can use this composite map to generate a prescription.

NOTE: If creating a prescription from a Composite Map you must first select the “Contour” icon.

• For more information on Prescriptions, click here.

Generate Composite Map Using Merge/Replace Composite Option
1. Select the “Maps” icon.

2. Expand the map tree to open a map layer.

3. Open a second map layer in the same tab.

4. Click on the “Composite” icon located below the Map Layers Window in the lower left corner.

5. A window will appear with two options, select “Merge/Replace.”

6. Select “OK” to proceed; selecting “Cancel” will cancel out of the composite map creation screen.

7. You have the option to save or not save the composite map. If you wish to save, enter a unique name and select “Save.” Select “Don’t Save” if you wish to not save the composite map and proceed to create the composite map. If you save the composite map you will be able to use this map in the future to create prescriptions.

NOTE: If you do not save the composite map then the new composite map will open in a new tab and once you close the tab you will be prompted again to save. If not saved and the window is closed you will have to generate the composite map again.

8. The composite map will be generated and saved in the Map Tree under the field in “Composite maps” as an operational layer.
   • You can use this composite map to generate a prescription.

NOTE: If creating a prescription from a Composite Map you must first select the “Contour” icon.

• For more information on Prescriptions, click here.

## Composite Map Legend

Once you have created a composite map you can view the composite map legend from the Legend tab in the Functional Area.

1. Expand the Map Tree to the “Composite Map” layer and select the composite map you want to view.

2. Select the “Legend” tab. You can view the legend and its associated characteristics. (for more information see below)

Composite maps are calculated differently depending on differences in crop type. If the same crop type is used for input on all map layers (i.e., 3 years of corn data), then the method will average yield for all years. If the crop type varies (i.e., one year of soybean data and two years of corn), then the method will first normalize yield by year, then average the normalized data across years. Normalization in this example is important for several reasons:
   • Using normalized maps equally weights data layers across years so one year does not influence the composite maps more than another year.
   • Normalized yield maps also enable two or more crop types to be used in the composite maps.
   • Using two or more crop types in a composite map may be useful for devising management zones for some purposes but may not be appropriate for other purposes.

Apex offers three different methods for normalizing composite maps. These methods are “Standard Normal (default),” “Mean Adjusted” and “Relative Adjusted.” To change the default method go to “File > Preferences > Maps > Normalization Procedure.”

• For more information on Normalization, click here.

## Composite Map Summary

1. Expand the map tree to the “Composite Map” level and select the composite map you want to view.

2. Select the “Summary” tab. The following details can viewed in the summary panel:
• If same crops were used then summary will display the following: Date created, map layers used (along with crop and task), rate layer, area, crop total and average.
• If different crops were used then summary shall display the following: Date created, map layers used (along with crop and task), rate layer and area.

**Composite Map Create Functional Area**

You can create “Guidance, Boundary, Prescriptions and Flags” using the composite map “Create” function.

1. Expand the Map Tree to the “Composite Map” layer and select the composite map you want to view.
2. Select the “Create” icon.

**Print Composite Map Summary**

1. Expand your Map Tree to the “Composite Map” layer and open the composite map layer you want to print.
2. Click the drop down arrow on the “Printer” icon. You will have two options:
   • Selecting “Print Map” will prompt you to select a printer. Once you select a printer click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   • Selecting “View Map” will open the composite map summary report. In this report page you will be able to print and export the composite map summary.
Flags

View Flags in Apex

To view flags marked in the field

1. Unload your data that has the associated flags to be viewed.
   • Refer to Unload topic for more information.
2. Select the “Maps” icon in the Top Navigation Bar.
3. Expand the Map Tree to the year layer and open the flag layer.
4. Select the flag you want to view.

NOTE: Flags will be sorted by name in Apex. e.g. all rocks that are unloaded or created in Apex will be saved under one rocks map layer.

Create Flags

Flags can be created using the following map layers: Operational layer, aerial image, boundary, prescription, composite map or management zone.

Select the “Create Flags” drop down box. You will have two choices; you can select “New Flag” or “Add Flag” to an existing flag session. The new flag will add an additional grid. Add flag will add a new grid to an existing flag layer. You can expand and collapse the added grid by selecting the “+” or “-” box next to the grid. This allows you to keep the same flag types in the same flag session in the GS2.

1. Expand the Map Tree and open any of the above map layers.
2. Select the “Create” tab and click on “Flag.” This will open a grid with multiple columns.

NOTE: Once you select the flag link, map features such as Map Tree Filter, Map Tree, Map Layers Window, and several map tools will be disabled. To enable these features select “Cancel” or “Done/Save.”

3. Select the year the flag will be associated with.
4. Select a flag name from the “Flag Name” drop down box.
   • This drop down is populated based on the flag names present in the setup screen. If you do not see a flag name in the drop down box select the “New” link. This will take you to the setup screen for flags.
   • For more information on Flag setup, click here.
5. Select a “Flag Type.”
   • There are three flag types: Point, Line and Area. By selecting a flag type Apex will enable the available drawing tools for you to use when creating the flag. For example if you are creating an Area flag two drawing tools will be available, the rectangle drawing tool and the poly line drawing tool. In the tool bar above the grid, you will need to select the appropriate drawing tool to draw the shape in the Map Viewing Area.
6. To change the color of the flag, click on the color box in the “Flag Color” column. Select a new color for the flag and then select “Ok.”
7. Select the appropriate drawing tool and draw the shape or select the point on the map for the flag.
   • To enter the exact location of the flag, select the “Show more details” check box to the lower left of the grid. This will expand your grid allowing you to enter the specific location for the flag.
8. To add another flag to mark the location of the same type of object or condition, select the “Add flag” tool from
the flag drop down. You can add as many flags as you want.

9. Select “Save” when finished creating your flags or “Cancel” to ignore any changes.
   • Once flags are saved, they will appear in the Map Tree under the specific field, year and flag name.

### Drawing Tools

- Center Pivot Tool
- Rectangle Tool
- Ellipse Tool
- Polygon Tool
- Bisect Tool
- Undo
- Redo
- Shape to top
- Shape up
- Shape to bottom
- Shape down
- Select all
- Clear all
- Delete
- Copy
- Assign Rates
- Point Flags
- Line Flags
- Area Flags

### Edit Name

Apex will allow you to edit flags created in the GS2 and Apex. GS2 created flags will be displayed in *Italic* and will
have limited editing features.

1. Expand the map tree to the “Flag” layer and select the flag layer to be edited.

2. Once the flag layer is open in the Map Viewing Area, click on the “Edit” tab.

3. A grid will appear allowing you to see the flag information. GS2 flags will be displayed in *Italic* and Apex flags will
be displayed in regular font.

#### GS2 created flags:
You can edit the year, name and color of created flags. All other information is read-only.

- If you change the year and select “Save,” the flag will be moved to the year selected.
- If you change the name of the flag and select “Save,” the flag will be saved with the selected name.
- To delete a flag select the flag from the grid or map view and then select the “Delete” icon, right mouse click and
select “Delete Selection” or use the “Delete” key on your keyboard.

#### Apex created flags:

You can move, resize, delete, change name, change year and color of Apex created flags.

- If you change year and select “Save,” the flag will be moved to the year selected.
- If you change the name of the flag and select “Save,” the flag will be saved with the selected name.
- To delete a flag select the flag from the grid view and then select the “Delete” icon, right mouse click and select
“Delete selection” or use the “Delete” key on your keyboard.

4. Select “Save” when you have finished editing the flags. Selecting “Cancel” will ignore any changes you made.
**Flag Legend**

Once you have created a flag layer you can view the flags you have created from the legend panel.

1. Expand the map tree to the "Flag" layer and select the flag layer you want to view.

2. Select the “Legend” icon.
   - Flag legend will display the color, number, flag name and flag type.

**Flag Summary**

1. Expand the map tree to the “Flag” layer and select the flag layer you want to view.

2. Select the “Summary” icon. The following details can viewed in the summary panel depending on the type of flag:
   - Flag Number
   - Flag Name
   - Flag Type
   - Flag Color
   - Start Point
   - End Point
   - Distance/Area

**Save Flag to Card**

1. Select the “Save” icon to save the flag to the data card.

2. Expand the Map Tree to the “Flag” layer and select the flag layer you want to save to card plus all the required information.
   - Refer to the Save to Card section for further information.

NOTE: Flags in the Map Tree layer are spatial flags created on the GS2 or in Apex. Flags created under the “Setup > Resources > Flag” are flag names. To save spatial flags you have to select the Flags layer under the Enterprise layer. Selecting the Flags layer under the Resources layer will save the flag names to the card.

**Print Flag**

1. Expand your Map Tree to the “Flag” layer and open the flag layer you want to print.

2. Click the drop down arrow on the “Printer” icon. You will have two options:
   - Selecting “Print Map” will prompt you to select a printer. Once you select a printer click “OK” to print the map. Selecting “Cancel” will close the printer prompt.
   - Selecting “View Map” will open the Flag layer summary report. In this report page you will be able to print and export the flag layer summary.
Crop yield is a calculated value. Calibration is performed to ensure that the moisture sensor data and the operator input are properly used by the mapping system to produce a final output in units of bushels per acre (or kilograms per hectare).

Calibrating your combine ensures accurate data for your mapping system. However, if you complete calibration after harvesting a few fields, or even midway through a field, your maps will show yield variations due to a revised calibration factor rather than a trend in the field. Harvest data collected after calibrating will reflect the new calibration factor while data that was collected prior to the calibration will be based off of the old calibration factor.

You can fix this variation by using the post calibration feature within Apex. **There are four ways to post calibrate the yield.**

- Calibrate by Field Totals.
- Calibrate by Harvest Date.
- Calibrate by Variety.
- Calibrate by Machine.

Planting, Tillage, and Product Application can also be post calibrated to fix any variation.
- Calibrate Planting - Tillage - Production Application.

The selection tools can be used to highlight an area on a map and calibrate by Machine or Variety. Data in Apex is recorded in regions, when post calibrating the entire region must be calibrated. Area selected to be calibrated will be gray once selected, ensure highlighted area is the area that needs to be calibrated. The check boxes at the bottom of the screen can be used to select additional areas or select cancel and use the selection tools again.

### Calibrate by Field Totals

Calibrating by Field Totals allows you to match your data in Apex to your scale tickets.

1. When viewing a harvest map, select the **"Edit"** tab.
2. Select **"Post Calibration."**
   - You can also access this from the Home Page. Select the North American region for Harvest. In the **"Harvest"** tab on the left hand side select **"Post Calibration."**
3. On the left hand side, select **"Field Total."**
4. In the window to the right, you will need to specify the data that you want to calibrate.

🌟 A red star represents required information.

5. After entering the required information, a second window will appear with the following fields populated:
   - Field, Current Wet Weight, Current Moisture, and Current Total Area.

6. To the left of the Field column, place a check in the box for the field that you want to calibrate. To select all fields select the **"Check All"** button and to uncheck all fields select the **"Uncheck All"** button. Your verified totals can be entered for the following:
   - New Wet Weight – Enter the verified wet weight for the field.
Apex User Guide

• New Dry Yield – Enter the verified dry weight for the field.
• New Moisture – Enter the verified moisture for the field.
• New Total Area – Enter the verified area that you prefer Apex to use.

7. Once you have entered the new values, select “Calibrate” and new calibration values will be calculated and transferred to the selected field. Selecting “Cancel” will ignore any changes.
• If a field is calibrated with the wrong value, place a check in the box for that field and select the “Original Values” button. This will restore the fields of Current Wet Weight, Current Moisture and Current Total Area to their original values before post calibration.

Calibrate Field Totals Using Scale Tickets

If you prefer, Apex will allow you to enter the individual scale ticket amounts.

1. To enter the individual scale ticket amounts place a check in the box for the field that you want to calibrate.

2. Select the “Tickets” button.

3. This will prompt “Scale Tickets” window.
• In the upper left corner of the window you will see a calculator and a “Delete Row” icon. To delete a row, click on the row you want to delete and select the delete row icon.

4. You can enter the Ticket Number, Weight, Moisture, and FM (Foreign Material) for each scale ticket.

5. To input multiple scale tickets, fill in the first row and press “Enter” on your keyboard, a new row will be inserted into the table.

6. Once you have entered the scale tickets, select “Done”. The ticket information will be calculated and transferred to the selected field.

7. Select “Calibrate” and the new calibration values will be calculated and transferred to the selected field. Selecting “Cancel” will ignore any changes.
• If a field is calibrated with the wrong value, place a check in the box for that field and select the “Original Values” button. This will restore the fields Current Wet Weight, Current Moisture and Current Total Area to their original values before post calibration.

Calibrate by Harvest Date

Calibrating by Harvest Date allows you to enter the correct calibration factor for data that was recorded with an incorrect calibration factor.

1. When viewing a harvest map, select the “Edit” tab.

2. Select “Post Calibration.”
• You can also access this from the Home Page. Select the North American region for Harvest. In the “Harvest” tab on the left hand side select “Post Calibration.”

3. On the left hand side, select “Harvest Date”.

4. In the window to the right, you will need to specify the data that you want to calibrate.

🌟 A red star represents required information.

5. After entering the required information, a second window will appear with the following fields populated:
• Harvest Date, Current Calibration and Current Moisture.
• To expand and collapse each table, toggle the “+” or “-” box that is located to the left of the “Field/Machine” information.

6. To the left of the “Harvest Date” column, place a check in the box for the field that you want to calibrate. To select all fields select the “Check All” button and to uncheck all fields select the “Uncheck All” button. Your verified totals can be entered for the following:
• New Calibration – Enter the correct calibration factor.
• New Moisture – Enter the verified moisture for the field.

7. Once you have entered the new values, select “Calibrate” and the new calibration values will be calculated and transferred to the selected field. Selecting “Cancel” will ignore any changes.

Post Calibration Planting-Tillage-Production Application

You can calibrate your recorded acres for your planting, tilling, and product applications files by clicking on the post calibration button in your Apex tool bar and then selecting the operations along the left side of the screen. This can be used to correct acres if you had some overlap and the machine is showing more acres than is in the field.
Operational Layers

Edit

The ability to edit specific map layer properties and map layers exists in the edit tab in the Functional Area. Not all layers have the edit option available. The following is a list of map layers this option is available for: Operational layers, boundary, Aerial imagery, guidance, flags, management zones, and prescriptions.

For a more detailed description on how to edit any of these map layers, click here.

Edit Data

After data has been unloaded from the card, Apex offers the ability to edit the setup information. In Apex, you have the ability to edit season, task, variety, width, machine, implement, operator, load properties, load content, chemical, or fertilizer. You also have the ability to post calibrate harvest data. If an item is not listed in a drop down menu, it may not be defined in setup.

Click here for more information about adding items to setup.

In Apex, you have the ability to edit:
- Season
- Task
- Variety
- Width
- Machine
- Implement
- Operator
- Load Properties
- Load Contents
You also have the ability to post calibrate harvest data.

**Edit Season**

If you need to correct data that has been unloaded in the wrong season you can make corrections by editing the season for that field. Changing the season will move the operational data to the modified season.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Season” in the edit window.
4. Select the new season from the drop down menu.
5. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

**Edit Task**

If you need to correct data that has been mislabeled you can make corrections by editing the task that the field is associated with. Changing the task name can also allow you to merge data together (i.e. merge yield data from two combines).

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Task” in the edit window.
4. Select the new task from the drop down box.
5. Select the new task from the drop down menu.
6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

**Edit Variety**

If you need to make a correction to variety data that has been mislabeled you can make corrections by editing the variety name that the layer will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Variety” in the edit window.
4. In the existing variety(s) box, place a check in the box next to the variety to be edited.
5. Select the new crop and variety from the drop down menus.
6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

**Edit Width**

If you need to correct machine/implement width data that has been mislabeled you can make corrections by editing the width that the field will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Width” in the edit window.
4. In the existing width(s) box, place a check in the box next to the width to be edited.
5. Enter the new width in the “New Width” box.
6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

**Edit Machine**

If you need to correct machine data that has been mislabeled you can make corrections by editing the machine name that the field will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Machine” in the edit window.
4. In the existing machine(s) box, place a check in the box next to the machine to be edited.
5. Select the new machine from the drop down menu.
   • You will also have an option to select a new machine type if needed.
6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

**Edit Implement**

If you need to correct an implement that has been mislabeled, you can make corrections by editing the implement name that the field will be associated with.

1. From the Map Tree, open the layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Implement” in the edit window.
4. In the existing implement(s) box, place a check in the box next to the implement to be edited.
5. Select the new implement from the drop down menu.
   • You will also have an option to select a new implement type if needed.

6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

### Edit Operator

If you need to correct an operator that has been mislabeled, you can make corrections by editing the operator name the field will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” icon.
3. Click on “Operator” in the edit window.
4. In the existing operator(s) box, place a check in the box next to the operator.
5. Select the new operator from the drop down menu.
6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

### Edit Chemical

If you need to correct chemical data that has been mislabeled you can make corrections by editing the chemical name that the layer will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.
3. Click on “Chemical” in the edit window.
4. Select the new product from the drop down menu.
   • You will also have an option to select a new product type if needed.
5. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

NOTE: Preferred units are for tank mixes only.

### Edit Fertilizer

If you need to correct fertilizer data that has been mislabeled you can make corrections by editing the Fertilizer Name that the layer will be associated with.

1. From the Map Tree, open the map layer that you would like to make changes to.
2. Select the “Edit” tab.

3. Click on “Fertilizer” in the edit window.

4. Select the new product from the drop down menu.
   • You will also have an option to select a new product type if needed.

5. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

NOTE: Preferred units are for tank mixes only.

---

**Edit Field Notes**

If you need to correct Field Notes unloaded from the display, you can make corrections by editing the Notes for the entire Field.

1. From the Map Tree, open the field and select any a map layer.

2. Select the “Edit” tab.

3. Click on “Field Notes” in the edit window.

4. Select a Note to edit from the list.

5. Information related to the selected Note will be displayed on the right hand side of the screen. Displayed information can be edited.

6. Click “Apply” for the changes to be saved or “Close” to ignore any changes.

NOTE: The Notes will be displayed in any report related to the specific field.

---

**Edit Notes**

If you need to correct Task Notes unloaded from the display, you can make corrections by editing the Notes for the entire Task.

1. From the Map Tree, open the Task and select any map layer for that Task.

2. Select the "Edit" tab.

3. Click on "Notes" in the edit window.

4. Select a Note to edit from the list.

5. Information related to the selected Note will be displayed on the right hand side of the screen. Displayed information can be edited.

6. Click "Apply" for the changes to be saved or "Close" to ignore any changes.

NOTE: The Notes will be displayed in any report related to the specific field.
Uninstall Apex

Apex 3.1 Uninstall

To uninstall Apex:

1. Close Apex, select “Start > Programs > GreenStar > Apex 3.1 > Uninstall Apex 3.1.”
   • This will prompt the windows Uninstall Wizard which will guide you through the rest of the uninstall process.

Uninstall GSDNet
Surface Water Management

Surface Water Management requires that you have knowledge of Maps and Tools.

Click on the **Maps** icon

Select a map that contains elevation data.

Click the **Create** button located at the bottom of the screen.

From the Water Management section you can choose to perform the following tasks:
- Ditch Track
- Drain Design

**Ditch Track**

Creating a Ditch Track requires that a map containing elevation data is on the Map Layers Window and Map Viewing window.

Click **Create** > "Ditch Track" > **New Track**

A new track name will appear. Tracks are named sequentially starting with Track 0.

Create Ditch Track

- Click on map to create control points for desired path
- Add points between existing points by clicking between points
- Delete points by clicking on them twice
- Move points holding click and moving them to desired position

Click "**Save**" button to save ditch track.
Click "**Cancel**" button to delete ditch track.

To delete a track after it has been saved, select the name or the track from the map and click delete.

If you choose to save the track, pop-up screens will appear: "You have successfully created your ditch tracks. Do you want to create the best fit drain for this ditch track set?"
If you click "No" button, a folder named "Ditch Set" will be created in the available maps section with the ditch named according to time and date.

If you click "Yes" button, Drain Design will start.

**Drain Design**

Click

Drain Design requires that a Ditch Track has been created and a map containing elevation data is on the Map Layers Window and Map Viewing window.

Click > "Drain Design"

Enter Minimum and Maximum of Cut and Slope.
Enter Cut Width.

Click

Apex may not be able to generate the drain with the Cut and Slope values that were entered. If this occurs, a flashing red exclamation. ! will appear at the front of the Track listing. Put cursor over the flashing exclamation for tips on what needs to be changed.

If drain was created a pop-up window will appear: "The drain design was successfully created. Use the elevation profile to edit the result."
Click "OK" button

Click on folder in Elevation Profile box.

**Editing the Drain Design**
Zooming in on control points helps when editing them.

Points can be added, moved, or deleted from the current design.
- To add click on the map area you want the new point to be.
- To remove a single point, double click on the point.
- To remove multiple points, use the selection and remove toolbar buttons.
- To move a point select and drag to a new location.

After editing drain design, you can Undo editing, Save, or Cancel.

**Maps from GSDNet**

**Elevation Data Map**

**Digital Elevation Map**
Drainage Map

Depression Map
Mobile Farm Manager

John Deere Mobile Farm Manager

John Deere Mobile farm Manager enables users to collect soil samples and make field notes to maps while in the field.

If Mobile Farm Manager has been purchased from local dealer and activated, Mobile Farm icon will be located in the top tool bar.

To sync data between a hand held device and Apex, ensure both devices are connected to the same Wi-Fi network. Internet connection is not required as long as both devices are on the same network.

When viewing the John Deere Mobile Farm Manager page there are options to either batch export maps from Apex to Mobile Farm Manager or import data from Mobile Farm Manager to Apex.

Export Data from Apex to Mobile Farm Manager

To export simply place checks in the boxes of the maps you would like to move then click Export

Import Data to Apex From Mobile Farm Manager

To import data from Mobile Farm Manager click on the Sync button, all the data that is available to move to Apex will show on the right side of the screen. Place checks in the boxes of data to bring into Apex and click the Import Button.
Apex™ to MyJohnDeere

User GUIDE

A guide to assist you through the process of backing up historical data on Apex™ and migrating it to MyJohnDeere Operations Center

CLICK THE ARROW TO GET STARTED
### Apex™ to MyJohnDeere User Guide Menu

<table>
<thead>
<tr>
<th>Overview</th>
<th>The Process (Overview)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean-Up Steps</td>
<td>General Data Guidelines</td>
</tr>
<tr>
<td>The “Me” Approach</td>
<td>The “John Deere Dealer” Approach</td>
</tr>
<tr>
<td>The “Restore” Process</td>
<td>Trouble Shooting</td>
</tr>
<tr>
<td>Resources/ Recommended Training</td>
<td>Frequently Asked Questions</td>
</tr>
</tbody>
</table>

To get started, choose a section to review or explore all the new features by using the arrows below.
Why Backup the Data?

- **Secure**
  - The Apex Backup Feature reduces the risk of lost data by storing it in your operations center on MyJohnDeere. In addition, we protect the business data you provide us through physical and internal controls, where you control who has access to the data.

- **Open**
  - John Deere embraces openness and compatibility with many software packages and non-Deere displays so you can continue to control where the data goes and when.

- **Accessible**
  - Help improve operations both inside and outside of the cab wherever you are using any internet enabled device. Manage your fleet, create and distribute setup files and make informed decisions on the go. Easily share access to the data with your trusted advisors and input providers to get real-time advice and prescriptions directly to your field via the MyJohnDeere.com storage.

- **Insightful**
  - Machine and production data is transformed into actionable insights to help support your ambitious yield targets in a sustainable and profitable manner. Easy to interpret farm management tools on MyJohnDeere.com can further reduce costs and maximize your profitability with every acre. Tools include report generation, variety maps and yield maps, which provides year over year yield comparisons and help identify addressable problem areas in your field.
Clean-Up Steps

Why clean-up the data?
- To get a better experience once the data is in the Operations Center

Tips to cleaning-up the data:
- Identifying Outliers in set of Values or Boundary
- Merging Multiple Field Documentation
- Correcting Crop Type Errors
- Duplicating Application Product Names
- Renaming a Variety
- Segmenting Multiple Fields Recorded as One
- Editing Dates

General Data Guidelines

Tips to keep in mind:
- Ensure Apex user is using Apex Version 3.7 or higher
- Use USB with enough storage space (Generally >8GB)
- Copy data from Apex™ to USB
- Eject the USB properly
- Place USB in safe place
- Remember the location of the safe place
- Label the USB
The Process (Overview)

The ‘Me’ Approach

- This Approach allows the customer to complete this process on his or her own. The customer will create the backup, as well as push the backup to MyJohnDeere.

The “John Deere Dealer” Approach

- This approach allows the dealer to interact with the customer. The customer will create the backup, put it on a USB drive, take the USB drive to a John Deere Dealer, where the dealer will then push the backup to MyJohnDeere.
The ‘Me’ Approach

Why choose the “Me” Approach?

- Customer is independent when it comes to technology
- Customer doesn’t want people “touching” his data
- Customer has faster internet than the John Deere Dealer

Beginning the Process

Go to ‘START’

1) Ensure you as the customer have created a MyJohnDeere account and have accepted the Deere Data Usage agreement.

2) Expand ‘All programs’

3) Expand ‘Greenstar’

4) Expand ‘Apex’

5) Open ‘BackupAndRestore’
Select 'Backup’

Click 'Continue’

Notes:

Selecting ‘Backup’ will create a backup. Selecting ‘Restore’ will allow the customer to restore from MyJohnDeere. He or she does not want to do that process at this point. The ‘Restore’ process can be found on pages 41-49.
Select the how you would like to backup Click ‘Continue’

**Notes:**
Selecting ‘MyJohnDeere’ will create a backup file compatible with MyJohnDeere’s Operation Center. If the customer selects ‘for safe keeping’ the program will simply create a normal backup file that will NOT be compatible with MyJohnDeere.
Select ‘To Upload My Data to MyJohnDeere myself’, if you, the customer, are performing the Backup.

**Notes:**

Selecting ‘Me’ means the customer will transfer his or her Apex data to MyJohnDeere themselves. The customer must commit to this process when he or she selects it, because it cannot be changed after this step.
 Ø **Click ‘Sign In’ to proceed to MyJohnDeere to log into your account**

---

**Notes:**

By signing in to MyJohnDeere, the customer is connecting his or her account information, which will pull in his or her organization details, allowing the program to know where to put this backed up data in MyJohnDeere.
The ‘Me’ Approach (cont.)

- Customers will have to agree to connect their Apex to their MyJohnDeere account

- Customers will then sign into their MyJohnDeere Account
Customers will have the opportunity to inform their locale dealer they are uploading their data.

Customers will then need to enter their zip code and the number they would like to be contacted on by their dealer.
Customers will then be shown a list of dealerships near their zip code. Select the preferred dealership and click continue.

**Notes:**

If your preferred dealership does not show up from entering your zip code you may want to try to enter the zip code of your dealership.
Customers can choose “no” they do not want to inform their dealer.

If the customer chooses no and continues they are given a chance to leave a call back number for one of John Deere’s call center technicians to call and give a free walk through of how to interact with their data in MyJD. Call will be for tutorial only and the number given will not be used for sales.
The ‘Me’ Approach (cont.)

- Open the ‘Select Organization’ dropdown. Select the organization you wish to backup.

![Select Organization dropdown](image)

**Notes:**
Selecting the organization is telling the program where this file will be placed within MyJohnDeere. **It is important to note that the customer needs to select the correct organization at this point.** This is critical to the rest of the process. If the Select Organization drop down locked in it is because the user only has access to one Organization.
The ‘Me’ Approach (cont.)

- Because there is no ‘**Last Backup date**’, select ‘**Full Backup**’

- Click ‘**Continue**’

---

**Notes:**

The first time this process is done, ‘Full Backup’ will automatically be selected. ‘Update Changes’ will come in use after the initial backup has been complete.
Once you start your backup, the backup process will require time before the information is viewable in MyJohnDeere

Click ‘Start Backup’ to begin the Apex Backup Utility

---

**Notes:**

The data may take up to a few days before being viewable in MyJohnDeere because the servers have to process the data, which takes time.
The ‘Me’ Approach (cont.)

- Required backup time depends on the following items:

  1) Internet Upload Speed
  2) Amount of Data
  3) Influx of Data to MyJohnDeere Servers

Notes:

Internet Upload Speed is probably the biggest factor in the process.

Influx of Data means that there is only so much space on the servers, so if there are a lot of backups coming in, it could take longer.
The ‘Me’ Approach (cont.)

- Backup is Complete
- Click ‘Close’ or ‘Open Apex’ to proceed

**Notes:**
At this point, the backup has been created and sent to MyJohnDeere. The customer can close out of the program and shut his or her computer down. He or she will then wait for confirmation that the backup has been uploaded and viewable in MyJohnDeere.
Once **all** data is uploaded, the MyJohnDeere **Organization Group Administrator** will receive this email.

**Notes:**

Once the backup has been processed by the MyJohnDeere servers and is viewable, the Organization Admin will receive this confirmation email.
The ‘John Deere Dealer’ Approach

Why choose the “John Deere Dealer” Approach?
- Customers who enjoy assistance with technology
- Customers who would like help from their dealer
- Customers with slow internet

Beginning the Process

Go to ‘START’

1) Ensure the customer have created a MyJohnDeere account and have accepted the Deere Data Usage agreement.

2) Expand ‘All programs’

3) Expand ‘Greenstar’

4) Expand ‘Apex’

5) Open ‘BackupAndRestore’
Select ‘Backup’

Click ‘Continue’

Notes:
Selecting ‘Backup’ will create a backup. Selecting ‘Restore’ will allow the customer to restore from MyJohnDeere. He or she does not want to do that process at this point. The ‘Restore’ process can be found on pages 41-49.
Select ‘John Deere Dealer’, if you, the customer, will create a backup for the dealer to upload.

Notes:

‘John Deere Dealer’ means the customer will save the Apex Backup to an USB and will take it to their John Deere Dealer. The customer must commit to this process when he or she selects it, because it cannot be changed after this step.
Notes:
By signing in to MyJohnDeere, the customer is connecting his account information, which will pull in his organization details, allowing the program to know where to put this backed up data in MyJohnDeere.
The ‘John Deere Dealer’ Approach (cont.)

- Customers will have to agree to connect their Apex to their MyJohnDeere account

![Image of Apex connection to MyJohnDeere account]

- Customers will then sign into their MyJohnDeere Account

![Image of MyJohnDeere sign-in page]
The ‘John Deere Dealer’ Approach (cont.)

➢ Click ‘Continue’

Notes:
After signing in and selecting the correct approach, the customer can now move forward with the backup process.
Ø Open the ‘Select Organization’ dropdown

Notes:
Selecting the organization is telling the program where this file will be placed within MyJohnDeere. It is important to note that the customer needs to select the correct organization at this point. This is critical to the rest of the process.
The ‘John Deere Dealer’ Approach (cont.)

➢ Click ‘Browse’ to search for the USB drive you will transport to your local John Deere Dealer.

![Backup And Restore window](image)

**Notes:**

By selecting ‘Browse’ the customer will be able to select the location he or she would like to store the backup file.
Navigate to a location to save backup file. Click ‘Save’

Notes:
The customer can select the location to save the backup file here. He or she does not have to save it to a USB stick here. The customer can save it to their desktop for example, and place it on a USB before taking it to the dealer.
The ‘John Deere Dealer’ Approach (cont.)

- Click ‘**Start Backup**’ to begin backup process

![Backup And Restore window](image)

**Notes:**

For this approach, the backup process will only create the backup file. It will not push the data up to MyJohnDeere. Instead, the customer will take the backup file to a John Deere Dealer, where they will push the data up to MyJohnDeere.
Required backup depends on the following items:

1) Internet Upload Speed
2) Amount of Data
3) Influx of Data to MyJohnDeere Servers

Notes:

Internet Upload Speed is probably the biggest factor in the process.

Influx of Data means that there is only so much space on the servers, so if there are a lot of backups coming in, it could take longer.

This should take a shorter amount of time compared to the ‘Me’ approach, because only the backup file is being created at this point. It is not creating the backup file AND pushing the data to MyJohnDeere at the same time.
The ‘John Deere Dealer’ Approach (cont.)

- Backup is Complete
- Click ‘Close’ or ‘Open Apex’ to proceed to Apex

Notes:

At this point, the customer will take the backup file, put it on a USB stick if the backup file was saved in another location, safely eject the USB stick, and take it to their John Deere Dealer.
Once the customer brings the USB to the dealership, the dealer personnel will open ‘Apex Backup Utility’

Notes:
The ‘Apex Backup Utility’ will be located in the ‘Options’ area of MyJohnDeere for dealers. It can be downloaded and placed on the dealer’s desktop straight from the Operations Center.
Select ‘Log In’ to enter the dealership credentials.

Notes:

The dealer will need to sign in with the dealership credentials, not the customer’s credentials.
Notes:

After entering the dealership credentials, ‘Sign In’.
Click **Browse** to navigate to location of backup file

---

**Notes:**

By selecting ‘Browse’, the dealer can then search for the customer’s backup file.
Navigate to backup file. Click ‘Open’

Notes:

Once the backup file has been found, select and open the file. Backup will be named ApexFullBackup.JDBak.
Once file backup has been uploaded, click ‘Send’

Notes:

Once the backup file has been selected, the ‘Organization Details’ will auto-populate. They cannot be changed at this point because the backup file is created for that specific Organization. So, if a customer has created a backup file to the wrong Organization, they have to start the process over.
Select ‘Send’

An estimated process time will be displayed in the ‘Apex Backup Utility’. Do not remove your storage device or shut down your computer during this time.

Notes:
The ‘Apex Backup Utility’ can be closed once the backup is uploaded to MyJohnDeere successfully.

Notes:
At this point, the dealer is finished with the process.
Once **all** data is uploaded, the MyJohnDeere Organization Group Administrator will receive this email.

---

**Notes:**

Once the backup has been processed by the MyJohnDeere servers and is viewable, the Organization Admin will receive this confirmation email.
The ‘Restore’ Process

Why choose the “Restore” Process?

- When you have lost the data in your Apex™ and need to pull it down from MyJohnDeere

Beginning the Process

Go to ‘START’

1) Expand ‘All programs’

2) Expand ‘Greenstar’

3) Expand ‘Apex’

4) Open ‘BackupAndRestore’
The ‘Restore’ Process (cont.)

- Select ‘Restore’
- Click ‘Continue’

**Notes:**
Selecting ‘Restore’ will allow the customer to restore from MyJohnDeere.
Click ‘Sign In’ to proceed to MyJohnDeere to log into your account.

Notes:
By signing in to MyJohnDeere, the customer is connecting his account information, which will pull in his organization details, allowing the program to know where to pull the backed up data from within MyJohnDeere.
Notes:

After entering the dealership credentials, ‘Sign In’.
Open the ‘Select Organization’ dropdown. Select the organization you wish to backup.

Notes:
Selecting the organization is telling the program where the data will be pulled from within MyJohnDeere.
The ‘Restore’ Process (cont.)

- Click ‘Continue’

![Backup/Restore dialog box]

**Notes:**
Selecting ‘Continue’ Will begin the ‘Restore’ process.
The ‘Restore’ Process (cont.)

- Restoring a lost database will only restore the information since the last backup. Select ‘Yes’ if you wish to continue.

Notes:

If there is information within Apex™ that has not been placed into MyJohnDeere, it will be erased by the ‘ Restore’ process.
Required restore time depends on the following items:

1) Internet Download Speed
2) Amount of Data

Notes:

Internet Upload Speed is probably the biggest factor in the process.

The bigger the file, the longer the ‘Restore’ process will take.
The ‘Restore’ Process (cont.)

- Restore is Complete

- Click ‘Close’ or ‘Open Apex’ to proceed to Apex

Notes:

At this point, the ‘Restore’ process is complete.
Trouble Shooting

- Without signing into MyJohnDeere, the customer will not be able to upload

Notes:
The customer must sign into their MyJohnDeere account. If they do not, the customer will be unable to proceed to the next step. By signing in, the customer is allowing the backup program to connect to the specific MyJohnDeere account that the backup will be placed into.
Trouble Shooting (cont.)

➢ The customer must have internet access to perform backup.

Notes:
Internet connection is needed while creating the backup and pushing it to MyJohnDeere. Internet is needed in order to configure the backup file to MyJohnDeere. If there is no internet connection, the customer cannot proceed to the next step.
Resources

**Demo Site**
- [http://myjohndeeredemo.deere.com](http://myjohndeeredemo.deere.com)
- Operations Center Demo POD – MyJohnDeere Landing Page
- Log in with Deere User ID and Password

**John Deere Video Content / Deere YouTube Channel**
- MyJohnDeere Overview plus series of 4 value videos

**MyJohnDeere**
- MyJohnDeere Help Files
- Operations Center – What’s New

**Ag Sales Manual**
- AMS - Information Solutions - MyJohnDeere
Recommended Training

John Deere University
- MyJohnDeere – Getting Started
- MyJohnDeere – Operations Center Fundamentals
- Data & Account Management Essentials

Customer Clinic/Event Materials
- MyJohnDeere Operations Center Value Guide
Frequently Asked Questions

If someone has multiple organizations, how does Apex™ differentiate between them?
Apex does not have organizations, only MyJohnDeere Operations Center does. Apex has clients and it backs up all clients in that dataset. Customer need their own organizations in MyJohnDeere Operations Center and should not be shared unless they are partners. The dealer will need to create a copy of their Apex backup for safe keeping, then go in and delete all but one client. After securing that backup and restoring the original, delete all but one client, upload that backup and repeat the process for each client.

When it comes to "Update Changes", if you change a file in Apex™ following the upload, does it update along with the new data?
Yes. Any changes in Apex will be reflected in MyJohnDeere Operations Center. It will be able to differentiate between what is new data, and what is old data.

What happens to the data that is already present in MyJohnDeere Operations Center?
It will reflect what is in Apex.

Will the customer be "timed out" if the backup/upload takes too long?
The customer will not be “timed out” when doing this process. If the process is stopped at some point (ex. Loss of internet connection) the process will pick up where it left off.

Once a backup file is sent, can it be used to restore Apex data, or does the file have to be fully viewable in MyJohnDeere Operations Center before it can be used to restore?
Customers do not have to wait for the data to become available on MyJohnDeere Operations Center to restore Apex data.

What happens to your legends when you restore?
Apex will restore the legends regardless of the file origin. However, legends in Apex will not carry forward to MyJohnDeere Operations Center at this time.
Frequently Asked Questions

Does the dealer need to be part of a partnership in MyJohnDeere with the customer, or can they do it for anyone?
No, as long as the dealer has a validated MyJohnDeere account, they can do this process. A 3rd party (agronomist) must be an admin of the organization.

Does the "Data Usage Agreement" need to be turned on for this process to work?
Yes, it does.

With information uploaded to MyJohnDeere Operations Center from the machine with Wireless Data Transfer (WDT), will there be a conflict with any of the backed up data?
WDT data and Apex data will not conflict. If the “Transfer Files” is activated, Apex will automatically download the WDT data from MyJohnDeere Operations Center. Any changes made to Apex data can be uploaded to MyJohnDeere Operations Center.

What justifies “historical” data?
The multiple years of Apex data that was not previously shown in MyJohnDeere Operations Center via Wireless Data Transfer.

Will historical application maps be available in MyJohnDeere Operations Center?
Yes.
Apex™ to MyJohnDeere Backup Feature

VALUE GUIDE

Unpublished work © 2014 Deere & Company. All Worldwide Rights Reserved. THIS MATERIAL IS THE PROPERTY OF DEERE & COMPANY. ALL USE, ALTERATIONS, DISCLOSURE, DISSEMINATION AND/OR REPRODUCTION NOT SPECIFICALLY AUTHORIZED BY DEERE & COMPANY IS PROHIBITED.